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INTRODUCTION 

1. Overview 

This manual is intended to describe in detail the process by which land use was determined for 

the COHYST study area during years 2006-2010.  The detailed steps and processes are intended 

to be described in a way so that the task and corresponding steps could be repeated for additional 

years of study. Graphics are including within the manual to illustrate certain processes where 

descriptions alone may be complex. The manual is broken into four main sections, each section 

being one of the four main tasks performed.  These four main tasks include: 

(Task I)  - Image Processing  

Begins with the evaluation and collection of raw Landsat satellite imagery. Select images 

 are  processed into a format for classification analysis and stored in a standardized 

 collection framework.  

(Task II)  - Parcel Editing  

Entails developing an agricultural parcel GIS database for the entire COHYST study area. 

 Each year having individual yearly ground-based representations derived from aerial 

 photographic interpretation. 

(Task III)  - Image Classification  

Utilizes processed imagery from the image processing task to develop and assign 

 agricultural crop types for each parcel created in the parcel editing task. Task 3 also utilizes 

 aerial image sources for classifications of supplemental static land cover.  

(Task IV)  - Irrigated and Non-Irrigated Irrigation Separation  

Provides assigned irrigation status to each parcel. Irrigation status was determined by using 

 selected imagery from the image processing task and validated with ancillary reference 

 data  sources. 

 

2. Guidelines 

In order to obtain the final yearly land use products, several sub-processes and steps are needed 

for each task. Each process is documented, described and numbered; having its own title within 

this manual. The main objective of the specific process is described in the title and the table of 

contents to help navigation of the manual and the specific step.  

The manual is intended to be performed in a sequential order starting with Task 1 for each year 

of analysis. While efficiencies may be found in performing specific processes for multiple year 

simultaneously, its encouraged for a user to review the entire manual before beginning analysis. 

Additionally, a user should understand any future implications of the manual should utilize 

appropriate data sources and processes with technological change. 
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TASK I.  IMAGE PROCESSING 

3. Imagery Archive Review 

USGS Global Visualization Viewer (GLOVIS) and Earth Explorer Use / Inventory 

3.1.1. Register an account on the USGS EarthExplorer website: 

https://earthexplorer.usgs.gov/register/.  

3.1.2. Note: Task I Section 2 provides details steps for using GLOVIS for 

downloading selected scenes. It is suggested to review the entire archive prior to 

process ding with downloading to insure suitable imagery is available for a 

given year and period of study. 

3.1.3. Once connected to the GLOVIS web application a user can review the 

Landsat archives for image evaluation of temporal coverage and cloud cover 

percentages. The following example is used to describe a review of 2013 

Landsat 5 imagery for scene Path 32 Row 31 of the COHYST boundary. 

3.1.4. Before proceeding with the review of the online archive it is suggested to set 

up a tracking spreadsheet to record scenes and corresponding cloud cover 

percentages. Using the template spreadsheet 

“Imagery_XXXX_QC_TrackingTool_Temp.xlsx” update the dates available for 

each scene available by each frame. Enter the   ID. Columns Year, Julian and 

DOY will be populated from pre-built formulas. Finally, enter the cloud cover 

percentage estimate for agriculture lands. Figure 1 shows an example of imagery 

reviewed for two COHYST frames. Step 1.1.7 provides details on estimating 

cloud cover percentages from agriculture lands.  

 

Figure 1.  “Imagery_XXXX_QC_TrackingTool_Temp.xlsx” 

https://earthexplorer.usgs.gov/register/
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3.1.5. Once connected to GLOVIS, select a Landsat Archive to begin review. 

Figure 2 shows how to turn Landsat 5 on.  

 

Figure 2.  Landsat Sensors selection 

3.1.6. It is suggested to load an existing agriculture lands shapefile for estimating 

cloud cover over these locations. Use the read shapefile tool to load a parcel 

layer. The parcel must be in a geographic coordinate system or the layer will not 

show correctly. Another useful layer to load is the COHYST study boundary.  

 

Figure 3.  Read Shapefile Dialog 

3.1.7. With loaded AOI shapefile, look at the estimated CC cloud cover for the 

entire scene. Now look at how the clouds appear to cover the specific AOI. 

Reduce or increase the estimate to better represent the AOI. Figure 4 shows the 
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area of interest for an example scene on 4/4/2013. Although the estimate CC is 

0% clouds can be seen in the Northern portion of the AOI. CC is more likely a 

better estimate of 5-10%. Record all information in the tracking spreadsheet, and 

then move to the next available scene for the frame until all scenes are recorded 

for the period of interest. 

 

Figure 4.  AOI Shapefile 

3.1.8. It is suggested to perform step 1.1.7 for all frames and scenes for a given 

year. Ideally, a minimum of one scene is recommended per month for each 

frame. Adjacent paths do overlap by approximately by one third on each side 

should be considered. 

3.1.9. With all available scenes reviewed from both Landsat 5 and 7 sensors, 

evaluate cloud cover percentages that will expectable for download.  

4. Imagery Selection 

USGS Global Visualization Viewer (GLOVIS) and Earth Explorer Use 

4.1.1. Register an account on the USGS EarthExplorer website: 

https://earthexplorer.usgs.gov/register/. 

 

Figure 5.  Register Tab in the Upper Right Corner of the EarthExplorer Homepage 

4.1.2. Follow the registration instructions to create a USGS account. 

https://earthexplorer.usgs.gov/register/
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Figure 6.  USGS Account Registration Instructions 

4.1.3. Once the registration has been completed, access the USGS GLOVIS 

website: http://glovis.usgs.gov/ 

4.1.4. If a Java run application prompt appears, click Run. 

 

Figure 7.  Java Run Application Prompt 

4.1.5. Verify browser requirements to ensure the proper functionality of the 

GLOVIS website. 

 

Figure 8.  Browser Requirements Tab in the  

Bottom Left Corner of the GLOVIS Homepage 

4.1.6. On the Menu Bar click on the Collection tab. 

http://glovis.usgs.gov/
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Figure 9.  Collection tab on the Menu Bar 

4.1.7. Within the Collection menu, select Landsat Archive. 

 

Figure 10.  Collection Menu  

Displaying Dataset Collection Types 

4.1.8. Within Landsat Archive, select Landsat 4-5 TM. 
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Figure 11.  Landsat Archive Data Types 

Note: Within this list, there are different Landsat data types to choose from 

depending on what is needed for a data source such as resolution, number of 

bands, data coverage, and time period. For the COHYST project, Landsat 4-5 

TM and L7 SLC-off (2003->) were the data types used. 

4.1.9. On the Menu Bar click on the Resolution tab and select 240m. This changes 

the resolution displayed in the image display to a larger scale. 

 

Figure 12.  Resolution Menu 

4.1.10. Enter in the World Reference System (WRS-2) path and row for the image 

frame to be selected and then click Go. 

Note: The maximum allowable cloud cover for the frame can be set by 

clicking on the Max Cloud drop down menu but this will limit the number of 

scenes available for that frame depending on the cloud cover percentage 

chosen. 
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Figure 13.  WRS-2 Path and Row Designator Windows 

4.1.11. Select the acquisition date of the individual scenes within the imagery frame 

using the month and year dropdown menus and then click Go. This displays the 

first scene for that month chronologically. Additional scenes for the selected 

month, previous month, or next month can be viewed by clicking on the Next 

Scene and Previous Scene buttons. 

 

Figure 14.  Month and Year Dropdown Menus 

4.1.12. Once the scene has been selected, click the Add button. This adds the 

selected scene into the Scene List window. 

Note: Before selecting the image scene, verify the input parameters within 

the Scene Information window. 

 ID: the scene ID 

 Cloud Cover (CC): the estimated cloud cover 

 Date: the acquisition date 

 Quality (Qty): image quality value ranging from 0-9 

 

Figure 15.  Selected Scene Added in the Scene List Window 
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4.1.13. Additional scenes can be added to the scene list by changing the path and 

row of the frame and/or the date of the scene. Once the required scenes have 

been selected and added to the list, click the Send to Cart button. 

 

Figure 16.  Scene List Send to Cart Button 

Note: If not already logged on, a sign in screen will appear, enter in the 

username and password that was created for the USGS account. 

4.1.14. Within the Pending Scenes section, the Level 1 Landsat image can either be 

ordered or bulk downloaded depending on the product availability. Check the 

box that applies for the image. 

Note: The Level 1 Landsat Geotiff image is the primary product that needs to 

be downloaded since it has the seven bands that can be used for imagery 

analysis and processing. 

 

Figure 17. Order Imagery Download Option 

 

Figure 18. Bulk Download Imagery Download Option 

4.1.15. Click the Apply button. 

 

Figure 19. Pending Scenes Section Apply Button 

4.1.16. Click the Go to Item Basket button. 



 

COHYST  

 2010 Land Use  

Classification Manual 

 

    Created Monday April 21
th
, 2014                                                       Page 9   

 

 

Figure 20. Pending Scenes Section Go to Item Basket Button 

4.1.17. Within the Order section, verify the information for the scene being ordered 

by clicking on the Expand Scene List dropdown. 

 

Figure 21. Order Section Scene Information 

4.1.18. Click the Proceed To Checkout >> button. 

 

Figure 22. Order Section Proceed To Checkout Button 

4.1.19. Click the Submit Order button. 

 

Figure 23. Order Section Submit Order Button 

Note: This places an order for the scene that has been selected. An online 

order confirmation from USGS will be sent to the email address provided in 

the USGS account registration. A scene that is ordered can take up to two 

days to process. Once the order has been processed, another email will be 

sent from USGS notifying that the product is ready to be downloaded from 

the EarthExplorer website. A scene that is bulk downloaded will be available 

immediately to download using the Bulk Download Application. This will be 

explained in the Bulk Download Application tool section. 

4.1.20. Within the order confirmation summary section, review the order information 

and when finished, either logout of the website or click the Return to 

EarthExplorer button to go to EarthExplorer. 
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Figure 24. Return To EarthExplorer Button 

4.1.21. Access the USGS EarthExplorer website: http://earthexplorer.usgs.gov/. 

4.1.22. Login to the user account.  

4.1.23. Click the Data Sets tab. 

4.1.24.  

Figure 25. Data Sets Tab 

4.1.25. Within the Select Your Data Set(s) window, check the box for Landsat 

Archive – L4-5 TM. 

 

Figure 26. Select Your Data Set(s) Window 

4.1.26. Click the Additional Criteria tab. 

http://earthexplorer.usgs.gov/
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Figure 27. Additional Criteria Tab 

4.1.27. Enter the Landsat scene identifier for the image to be downloaded. 

 

Figure 28. Additional Criteria Landsat Scene Identifier Input 

4.1.28. Click the Results tab. 

 

Figure 29. Results Tab 

4.1.29. Click the Add To Bulk Download icon for the selected scene. 

 

Figure 30. Add To Bulk Download Scene Download Option 

4.1.30. Click the View Item Basket >> button at the bottom of the Results window. 
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Figure 31. View Item Basket Button 

4.1.31. Click the Proceed To Checkout >> button. 

 

Figure 32. Proceed To Checkout Button 

4.1.32. Click the Submit Order button. 

 

Figure 33. Submit Order Button 

4.1.33. Within the bulk download confirmation summary section, review the order 

information and when finished, either logout of the website or click the Return 

to EarthExplorer button to go back to EarthExplorer. 

 

Figure 34. Return To EarthExplorer Button 

Bulk Download Application (BDA) 

4.1.34. Download the BDA from the USGS EarthExplorer website: 

http://earthexplorer.usgs.gov/bulk/. 

 

Figure 35. Download Button for the BDA 

4.1.35. Sign in to the USGS registered account if needed. 

 

Figure 36. USGS Account SignIin 

4.1.36. Download and install the BDA. 

4.1.37. Open the BDA. 

http://earthexplorer.usgs.gov/bulk/
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Figure 37. BDA Icon 

4.1.38. Login using the username and password for the registered USGS account. 

 

Figure 38. BDA Login 

4.1.39. Select the order to be downloaded and click the Select Order button. 

 

Figure 39. BDA Available Orders 

4.1.40. Choose the output location of the download by clicking on the folder browser 

icon in the upper right hand corner of the BDA. 

 

Figure 40. Browse Folder Location Icon 
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4.1.41. Click on the Begin Download button. 

 

Figure 41. Begin Download Button 

4.1.42. Once the download is complete, click on the Clear Completed Downloads 

button. 

 

Figure 42. Clear Completed Downloads Button 

5. Imagery Storage Structure and Extraction 

Server Storage Design 

5.1.1. Riverside developed a specific storage framework for all collected Landsat 

data used in organizing data. It is recommended to mimic the framework if a 

user wishes to use tools for additional processing. A user could modify all the 

tools to except other network system paths if a location other than the one used 

by Riverside is needed. Riverside used the following directory for imagery 

storage and extraction: D:COHYST\Landsat. 

5.1.2. Within the processing directory a yearly folder is used to store imagery by 

individual years. Looking at an example year of 2006, Figure 43 shows the 

corresponding sub-folders used. 

 

Figure 43. Subfolder Structure 

Unzipping 

5.1.3. Raw scenes selected for download are placed in the downloaded folder in zip 

format. Numerous zip utilities are available including 7zip and WinZip. Using a 
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zip utility, extract a scene to the downloaded folder as a single folder with the 

same scene ID as the folder name as seen in Figure 44. 

 

Figure 44. Unzipped Folder Naming 

Processing Organization 

5.1.4. Move the .tar zip file into the download_backup folder. Move the unzipped 

scene folder into the Processing folder under the corresponding path/row folder. 

The path/row directory is seen in Figure 45. 

 

Figure 45. Path/Row Directory 

5.1.5. Inside the corresponding path/row folder all unzipped scene folders should be 

seen as shown in Figure 46. 

 

Figure 46. Unzipped Folders in Path/Row Directory 

5.1.6. Inside the scene folder, all the raw files corresponding to specific 

downloaded scene are seen. Depending on the sensor, the number and name of 

files may vary. For the example L7 scene of 2006 the files seen in Figure 47 are 

available. 
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Figure 47. Example L7 Scene Files 

5.1.7. Insure the folder name for a given scene matches the base scene ID of the 

individual files inside. The scene ID should also match the Tracking Tool Temp 

Spreadsheet that is found in the yearly folder directory. Update the tracking 

spreadsheet to monitor and track download status by scene. 

5.1.8. Once all scenes have been: downloaded, unzipped and organized for a given 

year of study, a user can move to the first processing step. 

6. Imagery Processing 

Image Processing 

6.1.1. Using the specific image processing (IP) storage framework recommended 

by Riverside, the toolset developed by Riverside can be used to automate 

specific IP procedures. The tools are intended to be used once all Landsat 5 and 

7 imagery has been collected and extracted as described in section 3.3.2. 

6.1.2. A single directory stores toolboxes and scripts used in processing imagery. 

Tools are organized by software used in executing functionality. Figure 48 

shows the structure of tools used within the ESRI ArcGIS environment.  
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Figure 48. Structure of Tools Used within the ESRI ArcGIS Environment 

Compile Headers 

6.1.3. The compile headers script is used to remove all the  header files provided 

with Landsat imagery downloads and place them in a single directory for further 

processing. The tool dialog is seen in Figure 49 and specifies the processing 

directory containing Landsat imagery for a single year and the output folder to 

place all headers files.  

 

Figure 49.Tool Dialog 

Multi-Band Stacking 

6.1.4. By default all downloaded Landsat scenes are delivered in “tif” format by 

each band. The composite band script will go into each scene folder and compile 

all bands for a specific date into a single IMG file, using the scene ID for raster 

name. A user will need to change the background script to use the L7 script to 

correctly reference band 6. Figure 50 shows the tool dialog for entering a 

directory for band stacking. Run both Composite_bands.py and 

composite_Bands_L7.py if collections from both sensors was performed. 
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Figure 50. Tool Dialog for Entering a Directory for Band Stacking 

6.1.5. The resulting IMG file for each scene can be seen in Figure 51. 

 

Figure 51. IMG File Output 

7. Imagery Correction 

TOA Correction for Landsat Data 

7.1.1. Open the spreadsheet called “TOA_Correction.xlsm”. Make sure to click on 

the tab called “START HERE” at the bottom of the spreadsheet once the 

spreadsheet is open. 
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Figure 52. Showing the Location of the START HERE Tab 

7.1.2. Change the name of the “pathname” and the name of the “meta file”. The 

pathname is the folder in which the Landsat meta files are located, and the meta 

file is the exact name of the meta file. 

 

Figure 53. Example showing where to change the pathname and meta file within the TOA Correction 

spreadsheet. 

7.1.3. Click on the gray “Press” button located in the box called “Press button to 

Read Metafile + for happy results” on the left hand side of the spreadsheet. After 

being pressed, there should be no warning messages other than messages 

indicating the pathname and meta file have changed.  

Note: All of the other cells that are highlighted in yellow within the 

spreadsheet will automatically update once “Press” is pushed.  

 

Figure 54. The button to click on once the pathname and meta file has been changed.  

7.1.4. At the bottom of the TOA Correction spreadsheet, click on the tab called 

“Metric model constants”.  

 

Figure 55. Showing the location of the Metric model constants tab. 

7.1.5. About halfway down the page, you will notice blue cells that have values 

within them. You will want to record specifically the “cos_theta_flat” value. 
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Figure 56. The red arrow shows the location of the cos_theta_flat value within the spreadsheet. 

7.1.6. Record the “cos_theta_flat” value in a different tracking spreadsheet. This 

tracking spreadsheet is called “Imagery_2006_QC_TrackingTool_Temp”. For 

following years (2007, 2008, 2009, and 2010), the name of the year was 

changed in the name of the spreadsheet.  

Note: Record the “cos_theta_flat” value from each individual scene into the 

“Imagery_2006_QC_TrackingTool_Temp” spreadsheet under the column 

labeled “Radiometric”. 

 

Figure 57. Showing where to record the cos_theta_flat value within the 

“Imagery_2006_QC_TrackingTool_Temp” spreadsheet.  

7.1.7. Repeat steps 5.1.2 through 5.1.6 for all scenes that are being processed.  

7.1.8. Within ERDAS Imagine, Click on the tab called “Toolbox” near the top of 

the screen.  

 

Figure 58. Example showing where the Toolbox tab is located in ERDAS Imagine. 

7.1.9. Click on the icon “Model Maker”.  
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Figure 59. Model Maker Icon 

7.1.10. Click on File → Open. Use the drop down button to navigate to the location 

of the TOA model. Select the model, and hit “OK”. 

Note: For Landsat 5 scenes, open the model called “ref_toa_metric_l5.gmd.” 

For Landsat 7 scenes, open the model called “ref_toa_metric_l7.gmd” 

 

Figure 60. Example of the “ref_toa_metric_l5.gmd” model that is used for TOA correcting Landsat 5 scenes.  

7.1.11. Notice the red boxes that show the variables that need to be edited for every 

Landsat scene (refer to later steps for more detail). 

7.1.12. Within the model, double click on the variable “Input TM data (1-7)”. Using 

the drop down menu, navigate to the workspace where the trimmed Landsat 

scenes are. Once the scene is selected, click “OK”.  

7.1.13. Double click on the variable “DOY” and in the value field, enter the date of 

the scene. Make sure you enter the date in Julian days. For example, if the scene 

date is 06/12/2006, enter the date as 163. The Julian date is also the last 3 

numbers of the Landsat scene.  

7.1.14. Double click on the variable “Cos(theta)” and in the value field, enter the 

cos_theta_flat value that was recorded in the Radiometric column of the tracking 

spreadsheet and click on “OK”. 
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7.1.15. Double click on the variable “Reflectance (TOA)”. Set the “File Name” to be 

the output .img file. Keep the name of the scene the same as the input Landsat 

scene, but add “_ref.img” to the end of the scene name to show that the scene 

has been TOA corrected. An example of an output scene name is… 

LT50290312006302PAC01_ref.img. 

7.1.16. Once the variables “Input TM data (1-7)”, “DOY”, “Cos(theta)”, and 

“Reflectance (TOA)” have been edited, click on “Process” → “Run”. This will 

run the entire model for the Landsat scene. All of the other variables within the 

model are static, and do no need to be changed.  

7.1.17. Repeat steps 5.1.12 through 5.1.16 for each Landsat scene until all of the 

Landsat scenes have been TOA corrected.  

Note: Keep in mind to use the correct model, depending on if the scene that 

is being TOA corrected is Landsat 5 or Landsat 7”. Refer back to step 5.1.10 

for instructions on how to change the model. 

8. Cloud Identification 

Manual Heads-up Cloud Identification 

8.1.1. Clouds will need masked for all Landsat scenes used in the COHYST 

project.  To insure the following standards are applied across all scenes, the 

following steps need applied: 

8.1.2. Create cloud shapefile. Shapefile will use the same projection for each scene 

it references. Use a naming convention of the following scene for each shapefile 

example “LT50290312006094PAC01_clouds.shp” Place the clouds shapefile in 

the corresponding scene folder as seen in Figure 74. 

 

 

Figure 61. Digitize Clouds 
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8.1.3. Load the layer stacked image, COHYST boundary and new clouds shapefile 

into an ArcMap session. Digitize Cloud shadow features at a 1:10,000-25,000 

scale. Only identify and mask clouds found within the COHYST boundary.  

8.1.4. Use various band combinations to re-identify clouds. 5,3,1 3,2,1 5,2,1 are 

good RGB indicators used in cloud identification. Flicker various combinations 

on-off to help identify clouds. Use at least four combinations of the same scene 

while reviewing for hard to identify cloud shadow occurrences. 

8.1.5. Insure all haze, jet contrails, and shadows are digitized into shapefile format. 

If the haze is almost impossible to recognize, exclude it from digitizing as digital 

numbers should be minimally altered.  

8.1.6. Save edits. 

Shapefile Cleanup 

8.1.7. Create an attribute field called “Factor”. Make the field type ‘Text’ and 

character length ‘10’. 

8.1.8. Run a dissolve command on the cloud features. 

8.1.9. Calculate the ID field equal to “0”. 

8.1.10.  Record the cloud presence in the yearly tracking sheet with an “X” in the 

field “Clouds digitized”. 

Alternative Cloud Identification by Classification 

8.1.11. For some instances of cloud cover, a classification approach can be used to 

identify cloud cover. Typically, the approach is only used for areas with large 

occurrences of small cumulus clouds. The approach minimizes the effort 

required from digitizing. The approach is not often used as it usually makes 

more sense to not use the scene. 

8.1.12. An unsupervised classification using 20-30 classes is used to isolate the 

clouds and cloud shadows. The cloud-covered scene is input into the 

classification and the remote sensing analyst must identify classes of clouds and 

shadows using the ERDAS Imagine signature editor and raster attributes. If 

there are classes in the unsupervised classification that are mixed (cloud shadow 

and lakes for example) the classes are further classified into smaller groups, a 

technique known as cluster busting. When the clouds and shadows have been 

isolated into unique classes the, final signature file is used to run a supervised 

classification on the cloud covered scene. The resulting classification is then 

used to create a mask (clouds and shadows = 0, all other classes  = 1). The mask 

is multiplied with the original cloud covered scene. The result is an image with 
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the clouds and shadows filled in with zeros. This method is preferred for scenes 

containing many clouds with unclear boundaries and multiple shadows. For 

more information on this process and the capabilities of ERDAS Imagine on 

isolating and manipulating individual cover-type signatures see the ERDAS 

Imagine Field Guide. 

9. Cloud Masking and Study Area Clip 

Remove clouds and clip tool 

9.1.1. Once clouds have properly digitized for each scene the image processing tool 

Remove_clouds_clip_study_extent  can be used to run through each scene folder 

to create a new IMG file where clouds have been removed and the scene has 

been clipped to a buffered COHYST study boundary extent. Figure # shows the 

dialog for running the tool. 

 

Figure 62. Cloud removal tool dialog 

9.1.2. The tool will look in each scene folder and search for a cloud shapefile. If no 

clouds are present, clipping will only be performed. The clipping operation uses 

the scene ID to call the corresponding AOI file for clipping. If clouds are found, 

the tool will remove clouds and then clip to the AOI file. Areas with 

corresponding clouds presence will have pixel values set to zero. For Landsat 7 

scenes, missing scan line areas will also have pixel values set to zero. Figure 76 

shows an example Landsat 5 scene where clouds were removed and clipped to 

the AOI extent. 
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Figure 63. Resulting image with clouds removed 

 

10. Cloud Filling Procedure 

10.1.1. The cloud fill procedure that Riverside used requires a two step process. Step 

1, in which images are identified and selected to use in the cloud fill procedure 

and Step 2, in which the masked clouds are filled with the selected cloud free 

images.  

Identifying Landsat Images For Use To Fill Clouds of Masked Scenes 

10.1.2. Although the same process is used for both Landsat 5 and Landsat 7 to select 

imagery  to fill masked scenes with, there is a slight difference in the Landsat 7 

imagery.  

10.1.3. Open ArcMap. 

10.1.4. Using the “Add Data” icon, navigate to the location of the scene that has 

masked clouds. Click on the scene and select Add. The masked scene will be 

‘black’ in areas in which the scene needs to have filled clouds.  
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Figure 64. The Add Data icon 

 

Figure 65. Image with masked clouds in ArcMap. Notice the areas that used to be clouds are now black areas.  

10.1.5. Since many of the images taken form Landsat overlap, filling from adjacent 

frames is possible for certain frames. Refer to the tracking spreadsheet to see if 

the frame is eligible for filling from scenes of different frames. For example, for 

the year 2006, in the tracking spreadsheet called 

“Imagery_2006_QC_TrackingTool_Temp.xlsx” there are columns denoting 

whether or not the frame has a left fill option, and right fill option from other 

frames. If no right or left fill options are available, fill scenes will have to be 

taken from prior or later scenes.  

10.1.6. Using the “Add Data” icon, load the next closest date scene into ArcMap. 

This scene can either be an adjacent scene from a frame to the right (right fill) or 

left (left fill), or a scene of the same frame as the scene that has been masked 

and needs filled.  
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Figure 66. Showing the next closest date image in ArcMap This image was taken 16 days later than the masked 

scene that needs filled. Notice that this scene is cloud free, and thus will cover up all of the masked areas of the 

image beneath it that needs filled.  

10.1.7. Toggle the cloud free image on and off to see if the cloud free scene ‘covers 

up’ all of the masked clouds of the scene that you are trying to fill. If the scene 

does not fill all of the masked areas, bring in the next closest date scene and so 

on until all of the masked areas are covered.  

Note: Only use scenes that are no more than a month apart from the masked 

scene since ground cover, NDVI values, etc. can start to greatly vary if there 

is over a month of gap between scenes. 

10.1.8. If the scene selected for fill is from a frame to the right or left, record the 

frame and Julian date of the scene in the tracking spreadsheet.  

10.1.9. If the scene selected for fill is from the same frame (either prior or after), 

record the date in the tracking spreadsheet. 

 

Figure 67. Example showing a scene with masked clouds that has had images selected for fill. Notice this scene 

has fill scenes from both the right and left, as well as a fill scene from a later date. 
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10.1.10. Repeat steps 8.1.4 through 8.1.9 until all masked Landsat 5 images have had 

filling options evaluated.  

10.1.11. For Landsat 7 images after 2003, a scan line correction error occurred, so 

there are black gaps of no data in these Landsat 7 scenes. These gaps are linear, 

and are thicker near the edges of the scene. These gaps can be treated as masked 

clouds, and need to have imagery selected for filling the same as the Landsat 5 

scenes.  

 

Figure 68.  Portion of a cloud free Landsat 7 scene. Notice the red arrows pointing to the scan line gaps that 

all Landsat scenes following the year 2003 have. These black lines are areas of ‘no data’ so they can be 

treated the same as masked clouds and can be filled the same way as Landsat 5 scenes. 

10.1.12. Repeat steps 8.1.4 through 8.1.9for all Landsat 7 scenes.  

10.1.13. All Landsat 5 and Landsat 7 images that have had clouds masked and/or scan 

line errors (Landsat 7) should now have fill imagery selected. These masked 

scenes are now ready to be filled by the selected cloud free images. 

Filling Masked Clouds  

10.1.14. The process of filling the scenes that have masked clouds should only be 

started once all of the masked Landsat 5 scenes and all Landsat 7 scenes have 

had scenes selected for fill.  

10.1.15. Open the tracking spreadsheet for the year with the scenes that need filling. 
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10.1.16. Open ERDAS Imagine 

10.1.17. Within ERDAS Imagine, Click on the tab called “Toolbox” near the top of 

the screen.  

 

Figure 69.  Example showing where the Toolbox tab is located in ERDAS Imagine. 

10.1.18. Click on the icon “Model Maker”.  

 

Figure #. Model Maker icon. 

 

10.1.19. Click on File → Open. Use the drop down button to navigate to the location 

of the fill model. The name of the model used for filling masked clouds is 

“clouds_fill_new.gmd” Select the model, and hit “OK”. 
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Figure 70.  Showing the “clouds_fill_new.gmd” model that is used to fill the masked clouds. Notice the 3 

variables in the red boxes that are going to need to be changed for every scene.  

10.1.20. Double click on the variable “Cloudy Image (Replacer)”. This variable is the 

scene that has had clouds masked. Under the “File Name (*.img)” box, click on 

the yellow folder icon  and navigate to the workspace that has the first scene 

that needs to be filled. Click “OK”. 

10.1.21. Double click on the variable “Cloud Free Image (replace)”. This variable 

represents the next closest fill date that was determined in step 1. The fill scenes 

should already have been recorded in the tracking spreadsheet. Click on the 

yellow folder icon and navigate to the workspace that has the fill scene. Once 

the scene is selected, click on “OK”. 

 



 

COHYST  

 2010 Land Use  

Classification Manual 

 

    Created Monday April 21
th
, 2014                                                       Page 31   

 

 

Figure 71.  Showing the selected fill scenes for a given masked scene. Notice this masked scene only needs one 

other cloud free date to fully fill all of the masked clouds. Other masked scenes may need more that one fill 

scenes depending on the amount of masked clouds and if a right/left fill is used.  

10.1.22. Double click on the variable “Cloudy Image Replaced with Cloud Free”. 

This variable represents the output scene (.img) that will be the original masked 

scene with the new fill. Use the yellow folder icon to navigate to the output 

workspace where you want the new filled scene to go. Keep the same naming 

convention as the masked scene, except add “_fill1” to the end of the scene to 

show that the scene has been filled with 1 scene. An example name of a filled 

scene would be…’ lt50300322006181pac01_fill1.img’. 

10.1.23. Make sure the model has the correct ‘Area of Interest’ set. Each frame has a 

different area of interest (frame boundary), so this will need to be set for each 

frame. To set the area of interest, click on “Model”→ “Area of Interest…”. 

Press the “AOI File” radio button. Use the yellow folder icon to navigate to the 

location of the AOI files and click on the respective AOI file for the 

corresponding scene. For example, if you are filling frame 31032, the correct 

AOI file will be ‘31032.aoi’. Click “OK”. 

 

Figure 72. Changing the AOI for a frame. 

10.1.24. If the masked scene needs more than one fill scene to fill all of the masked 

clouds, use the last *_fill* scene as the “Cloudy Image (Replacer)” variable. For 

example, if the masked scene needs 3 fill scenes, the final fill scene should have 

the name ‘_fill3’ at the end of the final output fill scene.  
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Figure 73.  Showing the ‘un-filled’ masked scene. Notice the black areas being the masked areas that need 

filled. 

 

Figure 74.  Showing the same masked scene that has now been filled by another scene. Notice the red arrow 

pointing out the boundary of where the fill scene filled the masked scene. 

10.1.25. Use the “clouds_fill_new.gmd” model to fill all of the masked scenes, as well 

as all of the Landsat 7 scenes. Refer to the figures below for figures of Landsat 7 

scenes before and after filling. After the scene has been filled, record in the 

tracking spreadsheet  under the column “All of clouds covered?” whether or not 

all of the masked clouds have been filled.  
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Figure 75.  Showing the column where to note whether all of the masked clouds have been covered by the fill 

process. Some reasons for marking ‘NO’ may be that there wasn’t adequate cloud free fill scenes to fill with, 

or that the fill scenes are more than a month away from the masked scene and thus cannot be used for fill. 

 

Figure 76.  Showing a typical Landsat 7 scene. As mentioned before, treat the scan line gaps as masked clouds 

that need to be filled.  

 

Figure 77.  Showing the Landsat 7 scene, after the scan line gaps have been filled by another scene. Notice the 

red arrow pointing out the newly filled scan line gap. 
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11. NDVI Generation 

Generate NDVI For the Individual Image 

11.1.1. Once all clouds have been filled and instances of scenes with remaining 

clouds have been recorded within the tracking spreadsheet The Normalized 

Difference Vegetation Index (NDVI) can be calculated for each filled scene.  

11.1.2. Use the developed “NDVI” tool to automate the processing of NDVI results 

for each scene. Values are left at floating point scaled from -1 to 1.  Disk space 

for floating point precision is not much greater than integer. 

NDVI Composite Generation 

11.1.3. The NDVI Composite is produced by compiling each available coverage 

using the Composite Bands tool. Begin by right-clicking on your Toolbox menu 

and adding the following toolbox: 

COHYST\Landsat\Models\ESRI\Image_Processing.tbx 

 

Figure 78. Adding Composite Bands to Tool Box Menu 

11.1.4. In order to properly stack the imagery in the order of date taken it is 

necessary to use the following tracker as well:  

X:\Projects\COHYST\Landsat\2010\Imagery_2010_QC_TrackingTool_Crop

s.xlsx 

11.1.5. Column E in the spreadsheet corresponds to the Julian day of the year, which 

is also shown in the highlighted area of the coverage file name.  
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Figure 79. Spreadsheet tracking  

11.1.6. Add each clipped image from earliest to latest, in the order it appears in the 

spreadsheet. Only use the selected images that have the least amount of fill. In 

this case, only the images that are green under column O will be used for NDVI 

stack., The naming convention for the above NDVI composite is as follows: 

30032_NDVI_Stack_mMjjjJJAASS. This naming convention uses a lower-case 

letter for the first month beginning with the same letter, and then a capitalizes 

the letter of the next month of the same letter. In this case the name of this image 

shows that the bands were taken in this order: March, May, June, June, June, 

July, July, August, August, September, September 

 

Figure 80. Composite bands dialog 

11.1.7. Create a folder for your NDVI composites, and output your files there. Your 

NDVI coverage will initially show the first three available images for each band. 
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There will more than likely be gaps in coverage and bands of distortion; in 

addition to this, using only the first three bands will not give the three season 

view of the study area that is needed. Toggle the bands by clicking on the 

symbols for each band.  

 

Figure 81. NDVI results for frame 30032 

 

Figure 82. Band adjustment dialog 

11.1.8. The following image was achieved using a 1,5,11 band combination – or 

March, June, September. 
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Figure 83. Altered band adjustment for specific day combination 

 

Figure 84. Band adjustment set for May, Late--June, Early-September 

11.1.9. Each coverage will require some amount of adjustment; at times it is 

necessary to adjust the bands while working within the same coverage area in 

order to view changes in land use and to remove distortion in isolated areas.  

 

Figure 85. Example parcel review under three different band combination settings 
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Figure 86. 

11.1.10. The top row shows three different band combinations, while the second row 

shows three individual months. Using a variety of band arrangements as well as 

single month views can show planting and harvesting patterns, in addition to 

parcel and crop boundaries. It can be determined using the above collection of 

images that the crops in the left hand corners of this parcel may have been 

harvested sometime in late June to early July. 
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TASK II.  PARCEL EDITING 

12. Overview 

Objective 

12.1.1. The objective of this task is developing an accurate GIS dataset which 

contains individual yearly datasets representing all agricultural parcel 

boundaries within the COHYST study area.  

Definitions 

12.1.2. Agricultural Parcel – An area defined by a clear boundary where the soil has 

been altered for purposes of crop production or where feedlot operations are 

active. Parcels can be irrigated or non-irrigated. In addition, parcels which 

appear to be temporarily fallow should fall within this definition.  

12.1.3. Parcel Boundary – The parcel boundary should represent the true edge of the 

agricultural activities. County or City roads, farm buildings and homesteads, 

gravel or paved lots, on-farm ponds or lakes, or other non-agricultural use areas 

should fall outside of the parcel boundary. Small on-farm roads may be included 

within the parcel boundary. 

 

Figure 87.Parcel boundary adjustment to reflect area of  agriculture  

12.1.4. The images above depicts a parcel that required a change in geometry in 

order to remove the homestead. Changes in geometry to remove non-agricultural 

parcels may be performed using the Reshape feature tool in the editor toolbar.  

13. Editing Guidelines 

Maintain Topology 

13.1.1. Maintaining the topology rules can most easily be achieved by always using 

auto complete polygon when making parcel adjustments and enabling snapping. 
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When editing parcels it is not always possible to see where there are small gaps 

and overlaps – these errors in topology will become evident when performing 

topology validation at the very end.  

 

Figure 88.Topology error requiring adjustment  

13.1.2. Areas of parcel overlap such as this may be adjusted using the Reshape 

Feature editing tool.  

Provide Attribution for Feedlots  

 

Figure 89. Example feedlot 

13.1.3. The majority of feed lots will appear similar to the above image on NAIP; 

individual stalls will be visible and at times livestock can be seen grouped 
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together within these stalls. Feed lots will also appear very dark in color on 

Landsat NDVI imagery. 

 

Figure 90. Feedlot as seen by the Multi-Temporal NDVI 

13.1.4. Feed lots may be attributed quickly utilizing the following method. First, 

open the attribute table of the preceding year and select from the 

LANDUSE_TYPE field all features that are feed lots.  

 

Figure 91. Land use attribution dialog 

13.1.5. Once all feed lots have been selected, right click on the parcel shapefile for 

that year in the table of contents, go to Data, and then Export Data. This will 



 

COHYST  

 2010 Land Use  

Classification Manual 

 

    Created Monday April 21
th
, 2014                                                       Page 42   

 

export the selected parcels to a new shapefile showing feed lot parcels only. 

From here you will use the Feature to Point tool in order to create points that 

will be generated at the center of each parcel.  

 

 

Figure 92. Feedlot point based layer used in reviewing addition years 

13.1.6. From there a Selection by Location can be performed in order to calculate the 

location of feed lots into the new year. Begin by clicking on ‘Selection’ on the 

top menu and then Select by Location. Choose the shapefile of the year the 

values will be calculated into as the target year, and the feed lot point file as the 

Source Layer. Use ‘contain the source layer feature’ as the spatial selection 

method, and apply a search distance for 100 feet. The application of a search 

distance will be more important for attributing center pivots when using this 

method, in order to account for crop splits and yearly perimeter variability.  
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Figure 93. Feedlot selection dialog 

13.1.7. Once your selection is created begin an Editor session by clicking on the 

Editor toolbar and ‘Start Editing’. Open the attribute table of the target parcel 

year, click on ‘show selected records’ at the bottom of the table, and the right 

click at the top of the LANDUSE_TYPE field and select the field calculator. 

Enter “Feed lot” into the field calculator and this will enter this value into each 

selected record.  
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Figure 94. Feedlot attribution dialog 

13.1.8. This method may be used to attribute any feature, such as center pivots or 

golf courses; however, the study area must be reviewed for accuracy as the 

locations of features vary with each year. Feed lots may appear or be repurposed 

year to year, or the shape of the feed lot parcel may change and be missed by the 

Selection by location.  

Utilize Circle Construction Tool for Center Pivots 

 

Figure 95. Pivot construction tool 
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13.1.9. The circle construction tool should be utilized when adding new center pivot 

parcels; however, center pivots are best adjusted using the End Point Arc 

Segment tool in the editor toolbar. This tool will reshape uneven or improperly 

delineated pivot segments.  

13.1.10.  

Figure 96.  

Use Auto Complete Functionality for Parcel Adjustments 

 

Figure 97.  

13.1.11. Unless adding a new parcel that will not be connected to a pre-existing 

parcel, it is necessary to use Auto Complete Polygon to maintain proper 

topology and geometry. The following shows as example of adding a center 

pivot using the End Point Arc Segment tool with Auto complete Polygon 

selected.  

  

Figure 98. Parcel boundary adjustment 
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13.1.12. Using these tools ensures that your edits will conform to the existing 

geometry.  

Maintain Project Projection: NAD 1983 State Plane Nebraska FIPS 2600 Feet 

13.1.13. The proper projection may be maintained for all items in your MXD by 

setting your coordinate system in the data frame properties.  

 

Figure 99. Projection verification dialog 

13.1.14. Right click on the data frame in your Table of Contents and select properties, 

and then Coordinate System. This projection can be found under Projected 

Coordinate Systems >> State Plane >> NAD 1983 (US Feet). You can also 

maintain the proper projection for any geoprocessing outputs by setting the 

coordinate system in your environment settings, which can be found under the 

Geoprocessing tab in your top menu.  

 

Figure 100. Map projection assignment dialog 

13.1.15. Review and Perform Editing at a 1:5,000 – 1:6,500 Scale  
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Figure 101. Map scale set 

13.1.16. Parcel review and editing is more accurately done between a 1:5,000 – 

1:6,500 scale. Maintaining a constant scale can be done by setting a Fixed Scale 

extent under the Data Frame tab in your Data frame properties, in the same way 

as maintaining a uniform projection.  

Attribute Center Pivots  

13.1.17. Use the method described for Feed lot attribution in step 11.2.2 to begin 

Center Pivot attribution. Center Pivot irrigation is highly variable year to year, 

and so the attribution of this feature requires a greater review process than the 

attribution of other features. The NAIP must be reviewed to check for center 

pivot parcels that may have been added, repurposed, or parcels requiring a 

geometry change. Landsat NDVI imagery may be used in order to delineate 

center pivot boundaries that are hard to differentiate with NAIP imagery.  

NASS CDL 

13.1.18. The National Agricultural Statistics Service’s Cropland Data Layer will be 

used in combination with the NAIP imagery in order to detect the presence of 

crops. The CDL will also be used to differentiate between different crop types 

that may not have distinguishing features in aerial imagery. While the CDL will 

show the presence of a wide range of crops, the resolution is too poor to use this 

product alone when delineating parcels. When used with the NAIP, the CDL is 

an accurate guide to parcel boundary placement.  
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Figure 102.CDL raster overlaid with agriculture parcel boundary 

 

Figure 103. Agriculture parcel boundary overlaid with NAIP imagery 

13.1.19. The use of the CDL is necessary to create the initial general parcel 

delineations for the study area, and to provide a base for finer revisions using the 

Landsat NDVI imagery.  
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Landsat NDVI Archive 

13.1.20. Once a foundation showing parcel area and general land use is created the 

Landsat NDVI may be used in order to account for temporal variability in crop 

type. The NDVI will also show greater distinction between crop types, as well 

as aid in attributing center pivots. To begin using the Landsat NDVI bring in the 

file Frames_Append.shp in order to show available Landsat coverage areas. 

Along with seasonal band, these coverage’s will be toggled through while 

moving through the study area.  

 

Figure 104.Labeling Dialog 

13.1.21. Right-click on Frames_Append to open the layer properties, and go to layer 

properties. Check the label features box, set the label field to PR, and then use a 

text symbol setting that will be easily visible to you.  

 

Figure 105.Study area Landsat frames 
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13.1.22. There will be overlapping areas of coverage in some areas, which can prove 

to be helpful if you find that it is hard to get a cloud and distortion-free three 

season coverage in these places.  

 

 

Figure 106. Studay area review with Landsat frames  

13.1.23. The above coverage example is comprised of nine bands representing the 

following months: April, May, May, June, July, July, August, August, and 

September. When bringing your imagery the default setting will show the first 

three bands, which will more than likely have gaps in coverage, distortion, and 

cloud cover – in addition to not showing the three season picture needed for the 

temporal crop cover analysis. Toggle between bands until the desired image 

clarity and coverage is reached.  

 

Figure 107.Frame 30032 Multi-Temporal NDVI 
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Figure 108.  

 

Figure 109.Multi-Temporal NDVI with set band adjustment 

13.1.24. The above imagery was created using a May, June, September combination. 

The optimal combination will vary between each coverage that you use.  

 

Figure 110. CDL raster overlaid with agriculture parcel boundary 
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Figure 111 Agriculture parcel boundary overlaid with NAIP imagery 

 

Figure 112. Multi-Temporal NDVI with Agriculture parcel boundary 

13.1.25. The above is an example of the NDVI imagery identifying a crop split that is 

undetectable both in the CDL and NAIP. The NDVI is not always the best 

detector of crop splits and other features that must be captured – all available 

forms of information should be consulted for the greatest accuracy. The 

following shows an example where the CDL provides the greatest crop split 

detection.  
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Figure 113.  

 

Figure 114.  
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Figure 115. CDL shown split  

13.1.26. The CDL can also show where it is required to merge split parcels.  

 

Figure 116. CDL shown merge 

13.1.27. These parcels can be merged by selecting both of the target parcels and then 

choosing the ‘merge’ function in the editor drop-down menu.  

 

Figure 117. Editing save dialog 
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Figure 118. Auto-complete parcel addition  

13.1.28. There may also be instances where a parcel is visible with the NAIP and 

CDL, but does not register on the NDVI imagery. These parcels must be added 

using the auto complete polygon tool, or the polygon tool if isolated.  

 

Figure 119. Auto-complete parcel addition  

 

Figure 120. Auto-complete parcel addition 

Pivot Attribute Adjustment  

13.1.29. Once the Selection by Location method has been performed on the center 

pivots, a second revision must be performed to capture areas missed by the 

selection operation. The following example shows areas missed by using the 

previous year’s data depicted in red.  
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Figure 121.Pivot review 

13.1.30. In addition to this there may also be parcels attributed as center pivots which 

are no longer using center pivot irrigation. In this example we can see a parcel 

that was a center pivot in the year before, but has been left fallow in the current 

year.  

 

Figure 122.Pivot review 
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Figure 123.Pivot review 

 

Figure 124.Pivot review 
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Figure 125. Pivot review 

13.1.31. All three of these data sources will help show where center pivot boundaries 

require cutting as well.  

 

Figure 126. Pivot review 

NAIP Used in Actual Parcel Delineation 

13.1.32. When one imagery dataset is unavailable for one year, the datasets from the 

years before and after may be used to analyze the information that is available 

for that year. The following example uses NAIP imagery and parcels from 2007 

and 2009 to interpret parcel locations for 2008; there is no NAIP imagery for 

this year, but CDL and NDVI are available. This step can be performed in a 

number of ways – the goal is to identify changes that take place between the 

years before and after, which can also be confirmed with the data you have.  
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Figure 127. Pivot review 

 

Figure 128. Pivot review 

13.1.33. The above depicts parcels from 2007 in red and 2009 in black, using 2007 

NAIP imagery in the first image and 2009 in the second. The top of this parcel is 
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split between two crops in 2007, but is merged in 2009. The data you have 

available can be used to determine which of these parcel features appeared in 

2008. The following shows NDVI, CDL, and parcel data from 2008.  

 

Figure 129. Pivot review  

 

Figure 130. Pivot review  

13.1.34. Based on this it can be determined that the crop split remained in 2008.  
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14. Parcel Standardization 

Attribute Schema Standardization  

14.1.1. Attribute schema may be easily standardized through the utilization of 

domains. The use of domains will create a drop down list of commonly used 

parcel edits, which will mitigate the need to check for spelling errors and typos. 

The Domains toolset can be found within the Data Management toolset in Arc. 

 

Figure 131.Add Domain  

14.1.2. Begin by creating your domain.  

 

Figure 132. Add Domain  

14.1.3. Next, enter the values you would like to use in your attribute field with Add 

Coded Value to Domain.  
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Figure 133. Add Domain  

14.1.4. Once you have entered the desired values into your list, assign the domain to 

the table and field you wish to use your domain with.  

 

Figure 134. Add Domain  

14.1.5. Your domain will appear as follows when editing your parcels, based on 

which values you choose to use.  

 

Figure 135. Add Domain  
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Feature Attribution QC 

14.1.6. Attribution maybe checked for errors via querying individual values in the 

attribute table. 

 

Figure 136. Add Domain  

14.1.7. Once errors are identified, they may be selected out and then adjusted by the 

field calculator in order to create uniform naming conventions.  
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Figure 137. Attribute QC  

 

Figure 138. Attribute QC 
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Figure 139. Attribute QC 

 

Figure 140.Attribute QC 

Field Comments 

14.1.8. It is advisable to create a field for comments separate from your standardized 

edit field in order to identify parcels that may require review or have notable 

features. If there are multiple personnel working on parcel delineation for one 

year having a field for comments becomes especially helpful in communicating 

which parcels need further review.  

Topology Validation 

14.1.9. This step is to be performed once parcel edits and attribution QC is complete 

for each year. The first step is creating a new feature dataset within your 

geodatabase. 
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Figure 141.Topology validation 

14.1.10. Export your parcel shapefile into the feature dataset, then right-click the 

feature dataset icon and select New >> Topology. 

 

Figure 142.Topology validation 

 

Figure 143. Topology validation 
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14.1.11. Once your topology is created, validate your topology. Start an editing 

session, and drag your new topology into your table of contents – this will allow 

you to view your errors and make corrections. Begin by right-clicking on your 

topology and selecting properties. From the Errors tab you can generate a 

summary to view how many errors exist and which rules they fall under.  

 

Figure 144. Topology validation 

14.1.12. In order to correct these errors in topology, begin by opening the error 

inspector from the editor toolbar.  

 

Figure 145. Topology validation  
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Figure 146. Topology validation 

14.1.13. Using the error inspector you may view and correct individual errors, or 

select many errors that require the same correction.  

QA/QC Checking 

14.1.14. Once you have completed review for all years, use the following geodatabase 

format and naming conventions for your data.  

 

Figure 147. Parcel feature class organization 

14.1.15. X:\Projects\COHYST\Deliverables\Final_Parcel_Deliverable_4_26_13\COH

YST_2010_Landuse.gdb\Parcels\agparcels_2010 
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TASK III.  IMAGE CLASSIFICATION 

15. Instructions to Perform Crop Type  Maximum Likelihood Supervised Classification 

Classification Introduction 

15.1.1. The classification process involves multiple steps and utilizes two different 

software programs (ERDAS 2013, ArcMap10.1). Figure 147 shows the different 

trapezoid notation used with all procedures numbered corresponding to various 

procedures. 

 

  
Procedures 
in ERDAS 

Imagine 

 

Procedures 
in ArcMap 

 
 

Figure 148. Notation to Identify Model Used for a Procedure 

15.1.2.  Process Step.1 (Imagery Input) 

The classification process involves using prepared satellite imagery data from a 

multi-temporal composite of  Landsat bands (not including the thermal band) and 

a multi-temporal composite of Landsat based NDVI index. Landsat composite and 

NDVI composite cloud filled images are then stacked on a seasonal interval for 

each frame, based on cloud suitability and the number of image dates present for 

each frame.  Both composites contain input images from the cloud masking and 

study area clip procedure where frames were processed clipped to a buffered 

study area boundary.  

15.1.3. Process Step.2 (Ground Truth Input) 

The second part of the classification process involves separating reference data 

into subsets of training and test datasets for input and validation of the 

classification procedure. 

The reserved training ground truth data are available for classification 

procedures input once they have been checked using the multi-temporal NDVI 

evaluation. With any possible outliers removed, the shapefile can be negatively 

buffered by a distance of 30m for classification signature extraction.   

15.1.4. Process Step.3 (Classification) 

The third part if the classification involves performing the ERDAS MLC 

classification.  

15.1.5. Process Step.4 (Accuracy Assessment) 
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The forth part involves performing and evaluating accuracy assessment.  

15.1.6. Process Step.5 (Parcel Crop Assignment) 

The final component of the procedure involves crop type assignments to 

individual parcel layers. 

15.1.7. The following diagram shows the classification process in greater detail and 

in order of operation using corresponding software packages. 

 

 

Figure 149. Classification Processes Flowchart, page 1 

 

Figure 150. Classification Processes Flowchart, page 2 
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Figure 151. Classification Processes Flowchart, page 3 

 

Process Step.1 (Imagery Input) 

15.1.8. The NDVI composite generation process and results are used again in the 

classification procedure for validating  ground truth locations. The composite 

procedure is performed in addition for each frame using all bands, minus the 

thermal band. The resulting multi-band stack is used within the ERDAS 

classification process. 

15.1.9. Just as the NDVI images are stacked into a multi-temporal composite, the 

same can be done for the filled and masked Landsat images. Composite images 

are made on a frame-by-frame basis. 

15.1.10. Open up the spreadsheet ‘…TrackingTool_Crops’ for the respective year. 

You will see a column titled ‘Crop Classification Selection’. This column shows 

a number ‘1’ next to frames that have been selected to use for classification. 

These frames have been selected based on quality & amount of fill as well as the 

date of the scene to try to give good coverage throughout the year with 

minimally filled scenes. Both Landsat 5 and Landsat 7 scenes are used for 

Landsat Composites. 
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Figure 152. Showing the scenes that will be used for a Landsat composite image 

15.1.11. Open Arc Catalog. Search for the ‘Raster.tbx’. Within this toolbox you will 

see a tool called ‘Composite Bands’. Double click on it to open the tool.  

15.1.12. Navigate to where the clipped and filled images are that you want to 

composite. Click on the ‘+’ sign next to the image you want to drag in. This will 

show the bands of the image. Drag into the tool only bands 1, 2, 3, 4, 5, and 7 

from the selected images found in the spreadsheet into the ‘Input Rasters’ line of 

the tool. Leave out band 6 since this band is a thermal band which wasn’t used 

for this analysis. (Refer to the figure below). Make sure the images are in the 

correct order, starting with the bands from the earliest date in the spreadsheet 

first. Set the output workspace to a directory where each frame’s composite 

image will be stored. Give the output image a naming convention denoting 

which frame the image is a composite of.  
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Figure 153. The Composite Bands Tool used to make Landsat multi-temporal composites 

 

15.1.13. Repeat the previous step for all of the frames in order to get mulit-temporal 

composites for each frame. 

15.1.14. Each frame should now have its own composite image. Each band represents 

each band of the original image that was used to make the composite in order 

from earliest to latest. Since multiple layers from each image were used in the 

composite, there will be many bands within the composite depending on how 

many scenes were used. For example, if 5 scenes were used in the composite, 

the final frame composite should have 30 bands (since 6 bands were used from 

each scene). Band 1 of the composite should be band 1 of the earliest image 

used for the composite, and band 7 should be the first band of the second image 

used in the composite (second earliest image) and so on. 
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 154. The Composite Bands Tool results in a single img file for all selected bands 

Process Step.2 (Ground Truth Input) 

15.1.15. Ground truth data sets are an important input to the classification process and 

require careful review before integrating. Various source can be used to collect 

ground truth data, the following sources were available for the historic 2006-

2010 period: 

15.1.16. Using Google Earth street view, a road index was created showing county 

and state roads where photo-imagery was captured. Each road was then 

traversed in street view if crop cover was separable based on growth cycle and 

visual confirmation the location and crop type was recorded within a GIS layer.   

15.1.17. The NRD well program collects crop types for registered well. A given 

location is referenced to the PLSS section reference system. These locations 

were intersected with the corresponding year digitized parcel layer. Both 

locations are cross-referenced by area to insure a correct match. 

15.1.18. A layer titled “CALMIT 2010” was provided by COHYST for the year on 

2010. The layer is presumable the result of field based ground truth collections. 

The collector traversed the study are collecting reference data as available.   

Field data from actual in person field observation was only provided for 2010. 

15.1.19. Future work would benefit from a field collection program on a yearly 

interval for the corresponding year of study. It should be noted the Farm Service 

Agency (FSA) collects field data throughout the US under the common land unit 

program. As sited by the FSA website on 11/11/2013:  

Figure 16.#. Showing the layers of a 

final stacked composite image. This 

frame was stacked using 5 scenes, so 

there are 30 total layers.  
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Please be advised that with the enactment of The Food, Conservation, and Energy Act of 2008, 

Title I - Commodity Programs, Subtitle F - Administration, Section 1619 on May 22, 2008, the 

Farm Service Agency (FSA) is no longer allowed to make the geospatial data, including access 

to the Common Land Unit records, available to the public, even through the Freedom of 

Information Act (FOIA). Section 1619 is an Exemption 3 statute that prohibits FSA from sharing 

this data with the public. 

If regulation changes in relation to farm bill, the CLU dataset is a incredibly useful dataset for 

future  integration.  

 

15.1.20. Ground truth data can be extracted via Google Earth for use in determining 

actual crop types. Google Earth uses various dates for imagery, and as a result 

certain years within Google Earth’s ‘Street View’ can be used for corresponding 

years that fall within the COHYST years of study. Only 3 years are available for 

Google Earth Street View use. These years are 2007, 2008, and 2009. Using 

Street View imagery, locations and crop types can be editing using ArcMap to 

record the locations and crop types of locations referenced in Google Earth. The 

following steps outline the process used to capture locations and crop types of 

certain parcels for years 2007, 2008, and 2009. By looking at the Google Earth 

Imagery, certain crop types can be visually noticed based on certain traits of the 

crops. Common crops recorded from Google Earth are Corn, Soybeans, Alfalfa, 

Sorghum, Fallow, and Winter Wheat. If visible irrigation was seen in Google 

Earth such as center pivots, hoses, pipes, etc. this was also recorded. 

15.1.21. Launch Google Earth 

15.1.22. Drag and hover the orange street view icon over the imagery. This will show 

in blue the locations for which Google Street View is available.  
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Figure 155.showing the Street View icon (white arrow) and the available roads that can be used in Street View. 

 

15.1.23.  Zoom in to a road within the study area that you would like to start looking 

at. Insure you are looking at the right year of imagery in Street View. 

15.1.24. Open ArcMap, load the parcel shapefile for the respective year and zoom to 

the location that you chose to start looking at imagery and recording crop types 

and/or irrigation. You will have to visually compare common roads and 

intersections in order to align the locations of ArcMap and Google Earth.  

15.1.25. Within Street View, pan to the left and right of the street to look at the crop 

type and if irrigation is visible. Also note the date that the Google Imagery was 

taken. 
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Figure 156.Showing a crop (corn) location in Street View.  

 

15.1.26. Within ArcMap start an edit session and zoom to the parcel that is displayed 

in Street View. Use streets and imagery to zoom to the parcel location in 

ArcMap. 

15.1.27. Digitize a point within the center of the crop that is shown in both ArcMap 

and Google Earth Street View. Record the crop type and if irrigation is visible. 

After this is completed, you are now ready to keep moving down the street in 

Street View and record crop types and irrigation for other crops in the region.  

15.1.28. Record crop type locations as you feel necessary to get a good amount of 

crop data and a good spatial distribution of the crop locations.  
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15.1.29.   All available ground truth data that was collected and compiled into one 

shapefile and attributed by source. Use zonal statistics to extract the mean NDVI 

value for each parcel ground truth parcel. The results will be exported to excel 

and used to analyze NDVI trends for each parcel. This is used to identify ground 

truth parcels that may not have crop type correct. The NDVI trends throughout 

the year can be plotted on an Excel graph to help identify outliers that need to be 

removed from the ground truth parcels.  

15.1.30. Open up the main excel spreadsheet that has all of the ground truth data that 

has been gathered. The one used for this study is called 

‘2010_Neg_Mean_Signatures.xlsx’ with the year changing. 

15.1.31. Filter by crop type. For example, for corn you may want to filter using 

‘alfalfa’ and ‘dry alfalfa’ to select all of the ground truth data for alfalfa.  

 

Figure 157.A filter selecting Alfalfa and Dry Alfalfa.  

15.1.32. Copy each of the selected crop types into a different excel spreadsheet with 

each crop type being its own ‘sheet’ within the spreadsheet. It may be a good 

idea to use conditional formatting within excel to highlight high, middle. And 

low NDVI values. 

15.1.33. Insert additional sheets next to each crop type’s sheet that will be used to 

display the graphs of the NDVI trends for each crop type. A good naming 

convention may be something like ‘Sugar_beets_graph’.  

15.1.34. Insert a graph for each crop type in the ‘_graph’ sheet for each crop type. 

Select the parcel IDs and the mean NDVI values for each parcel ID as the Y-

axis data, and the NDVI date for each parcel as the X-axis data. Create a graph 

for each crop type.  
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Figure 158.Example of mean NDVI trend for sugar beets  

15.1.35. As visible in the previous graphic, a common NDVI trend can be visible for 

the sugar beet ground truth parcels. Outliers are also visible on the NDVI trend 

graph. Notice the parcel that the white arrow is pointing too… this parcel is 

likely not a sugar beet parcel based on its NDVI trend compared to the other 

sugar beet parcels.  

15.1.36. Remove outliers from the spreadsheet for each crop type. This will ensure 

that only valid ground truth locations will be used.  

15.1.37. Record which parcels got removed from the spreadsheet. This is important 

because the removed outliers also need to be removed from the shapefile that 

has all of the compiled ground truth data.  

15.1.38. Remove any parcels from the spreadsheet and shapefile that have been 

‘flagged’ from the original ground truth QC. Also, remove parcels that do not 

have any NDVI values for neither of the frames. 
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15.1.39. You should now have NDVI trend graphs for every crop type with the 

outliers removed. The NDVI trends for each crop type are different based on 

crop type, but a common NDVI trend should be seen for each crop type. With 

the outliers removed, you should now truly have quality ground truth data for 

the study area.  

15.1.40. Setting Aside Ground Truth Data For Accuracy Assement 

 Now that the ground truth has been finalized, it is now time to set aside half of the 

ground truth data to be used later for accuracy assessment. Only scenes that have 

at least 20 ground truth points per crop type need to be extracted. For example, if 

there are only four ground truth locations for potatoes, there is no need extracting 

two of the parcels for accuracy assessment. All four potato parcels will be used 

for classification. 

15.1.41. Within ArcMap, load the shapefile that has all of the compiled ground truth 

data minus the parcels that were removed from the NDVI trend verification 

process. 

15.1.42. Open the attribute table for the ground truth shapefile.  

15.1.43. Add two fields to the shapefile. One field called ‘Random’ and another field 

called ‘Accuracy’.  

15.1.44. Within the attribute table, use the ‘table options’ drop down menu and click 

on ‘select by attributes’.  

 

Figure 159.Table Options 

15.1.45. Select the crop type that you want to extract half of the parcels from. For 

example, if you want to select half of the corn parcels for accuracy assessment, 

within the ‘select by attributes’ dialogue enter “Crop_Type” = ‘Corn’. This will 

select all of the corn ground truth parcels.  

15.1.46. Right click on the shapefile layer within ArcMap and under the ‘Selection’ 

tab, click on’ Create Layer From Selected Features’. This will add a layer to the 

map that is all of the corn ground truth parcels.  

15.1.47. Open up the attribute table for this newly created layer. In order to get a good 

spatial distribution of the ground truth parcels, half of the parcels will need to be 

extracted from each frame. For example, if frame 32031 has 40 parcels of corn 

and frame 30031 has 30 parcels of corn, 20 parcels of corn need to be extracted 

from frame 32031 and 15 parcels of corn need to be extracted from frame 

30031. 
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15.1.48. Select by attributes all of the crop type that fall within the first frame. For 

example, to select all of the corn that falls within frame 29031you want to type 

“Crop_Type” = ‘Corn’ and “29031_1” < > 0. This will return all of the corn that 

falls within frame 29031. 

15.1.49. Right click on the shapefile layer within ArcMap and under the ‘Selection’ 

tab, click on ‘Create Layer From Selected Features’. This will add a layer to the 

map that is all of the corn ground truth parcels within frame 29031.  

15.1.50. Start an edit session.  

15.1.51. Open the attribute table for the newly created layer. 

15.1.52. Right click on the field ‘Random’ and select ‘Field Calculator’. 

15.1.53. Now assign random numbers to the selected parcels to ensure that half of the 

parcels will be pulled out with random order. Within the ‘Field Calculator’ 

dialogue, make sure the Parser is set to VB Script and that the ‘Show Code 

block’ radio button is checked. Within the ‘Pre-Logic Script Code’ copy and 

paste the following: 

15.1.54. dim max, min 

max=20 

min=5 

x=(Int((max-min+1)*Rnd+min)) 

 Set the max to be the upper limit of the random numbers and the min to be the 

lower limit of the random numbers. So if for example you want the random 

numbers to go from 1-20, set the max=20 and min=1.  

Within the ‘Ran =’ codeblock, enter ‘x’ 

Select ‘OK’ 
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Figure 160. Field Calculator dialogue for calculating random values. 

15.1.55. The field ‘Random’ will now be assigned random values. 

15.1.56. Right click on the field ‘Random’ and click on ‘Sort Ascending’. This will 

list the random values from largest to smallest. 

15.1.57. Select either the top half or the bottom half of the random values. For 

example, if you have random values ranging from 1-20, select values 1-10 or 

11-20.  

15.1.58. Within the ‘Accuracy’ field enter a ‘1’ for the selected values. The unselected 

values should all have ‘0’ in the ‘Accuracy’ field. The parcels that now have ‘1’ 

for ‘Accuracy’ will be used for accuracy, and those that have 0 of ‘Accuracy’ 

will be used for classification.  
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Figure 161. Showing how parcels that will be used for accuracy are determined.  

15.1.59. Repeat these steps for every frame in which the crop has ground truth 

parcels. For example, if you just did this step for 29031 corn, next you want to 

move on to 29032 corn. 

15.1.60. Also repeat the steps for all of the crop types that have at least 20 ground 

truth parcel locations.  

15.1.61. After all of the crops and frames for each crop type have been assigned 

random numbers and either ‘0’ or ‘1’ for ‘Accuracy’, the parcels that have been 

assigned a ‘1’ for ‘Accuracy’ are now ready to be removed for accuracy.  

15.1.62. Within the main ground truth shapefile, open the attribute table. 

15.1.63. From the ‘table options’ drop down menu click on ‘Select by Attributes’ and 

enter ‘Accuracy” = 1  

15.1.64. All of the crops that have been assigned a ‘1’ in the ‘Accuracy’ field are now 

selected and ready to be exported. 

15.1.65. Right click on the ground truth shapefile and click Data → Export Data… 

 Chose your workspace to export the data to and give the data a name to know that 

the data is to be reserved for accuracy.  
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Figure 162. The ‘Export Data’ dialogue 

 

15.1.66. Now that the parcels that are to be used for accuracy have been exported, 

parcels that will be used for classification need to be exported on a frame-by-

frame basin.  

15.1.67. Within ArcMap, open the attribute table of the ground truth parcel shapefile. 

Just like the previous step, click on ‘Select by Attributes’. Since you want to 

export all of the parcels that have been assigned ‘0’ in the ‘Accuracy’ field and 

also parcels based on frame, enter “Accuracy” = 0 AND FRAME< > 0 with 

FRAME being the field that you want to pull the parcels from. For example, if 

you want to select all of the parcels that will be used for classification in frame 

29031 enter… "Accuracy" = 0 AND "R29031_1" < >0. 

15.1.68. Now the parcels that will be used for classification are now selected for one 

frame. Next you need to export this data to its own shapefile.  

15.1.69. Right click on the ground truth shapefile and select Data→Export Data… 

When writing to your output location, be sure to specify the frame that is being 

exported.  

15.1.70. Repeat these steps until all of the frames with ‘0’ in the ‘Accuracy’ field are 

exported. 

15.1.71. You should now have  
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15.1.72. - One main ground truth shapefile 

15.1.73. - Ground truth shapefile for accuracy assessment (all of the 1’s). 

15.1.74. - Individual ground truth shapefile for each frame (0’s) 

 

15.1.75. Manual Addition of Additional Ground Truth Locations 

  Although most of the ground truth data adequately covered each frame for each 

year, some additional ground truth data needed to be added for frames that were 

lacking certain crop types or didn’t have enough ground truth locations for certain 

crops. For example, if a frame had less than 5 locations of corn, soybeans, alfalfa, 

winter wheat, fallow, and sorghum then more ground truth locations needed to ba 

added. This was accomplished by looking at the NAIP imagery, NDVI stacks, and 

the CDL classification. 

 

15.1.76. Launch Arc Catalog. Create a new shapefile that will be used to record 

additional ground truth locations. This shapefile needs to have polygon 

geometry. Create a new ground truth shapefile for every frame.  

15.1.77. Bring the newly created ground truth shapefile into ArcMap. Also bring in 

the NAIP imagery from the year, the specific CDL for the year, as well as the 

frames NDVI stack for the year.  

15.1.78. Zoom in to a scale that is reasonable for accurately identifying crop types. A 

scale of 1:5000 seems to work well.  

15.1.79. Pan around using the CDL as a reference to locate crops that need more 

ground truth points (i.e. common crops that have less than about 5 current valid 

ground truth locations. 

15.1.80. Start an edit session. 

15.1.81. Digitize a polygon that defines the crop type that needs added.  

 The example graphics below show an example of how a parcel of fallow is added 

as a new ground truth location using the CDL. The CDL shows the parcel as 

being fallow, and the imagery shows the parcel as being brown in color, barren, 

and is indicative of a parcel that has no ‘active’ crops and is thus fallow.  
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Figure 163.Showing the parcel in red classified according to the CDL classification.  

 

 

Figure 164.Showing the parcel in red with the NAIP imagery in the background. Notice how barren the parcel 

look compared to the adjacent crops. Since the CDL has the parcel classified as fallow, and since the parcel 

appears fallow in the NAIP imagery, it would be safe to call this parcel in fact fallow.  
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15.1.82. After the parcel has been digitized, record in the attribute table the value that 

is associated with the certain crop type. For example, fallow is classified with a 

value of ‘19’, so ‘19’ would be added to the ‘Value’ field of the attribute table of 

the newly digitized fallow parcel.  

15.1.83. Continue to digitize and attribute additional ground truth parcels until 

between 5-10 ground truth locations exist for the main crop types within the 

frame. For example, don’t worry about having 5-10 sunflower ground truth 

locations if the frame only has a few/no locations of sunflower according to the 

CDL.  

15.1.84. After additional ground truth locations have been added for the frame, save 

your edits and open up the ‘GT_Format_For_Classification’ model. This model 

will merge the newly created ground truth shapefile with the already existing 

ground truth data, clip to the respective frame boundary, and create a raster of 

the two combined ground truth shapefile which will then be used for 

classification.  

15.1.85. Set the ‘Output Train Raster’ to your workspace. 

15.1.86. Set the ‘L Stack for snap’ to be the NDVI stack that was previously created 

for the frame.  

15.1.87. Set the ‘GT with Value added’ to be the recently created ground truth 

shapefile that has your newly digizitized ground truth parcels. 

15.1.88. Set the ‘Frame Shapefile’ to be the frame boundary or area of interest (a.k.a. 

‘AOI’)  

15.1.89. Set the ‘GT with Value added 2’ to be the existing ground truth shapefile that 

existed before any new ground truth locations were digitized.  

15.1.90. Select ‘OK’ and the model will run giving an output raster that will be used 

for training the classification. 

15.1.91. Repeat these steps for all of the frames of interest.  
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Figure 165. The ‘GT_Format_For_Classification’ model 

15.1.92. 1Ground Truth Verification using NDVI Composite Stacks 

 Additional ground truth data can also be verified by using NDVI composite stacks 

that were created. All groups show different NDVI signatures, and thus common 

NDVI trends can be seen within alike crops.  

15.1.93. Launch ArcMap.  

15.1.94. Bring in the CDL from the year you want to add ground truth data to. Also 

bring in the NAIP imagery from the year.  

15.1.95. Depending on the frame that you want to add ground truth data to, bring in 

the NDVI stack that corresponds to the correct frame. 

15.1.96. Pan around the CDL and NAIP imagery to try to find crops that you need to 

add additional ground truth data to. For example, if you need to add additional 

sorghum, pan around the CDL for sorghum.  
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Figure 166. Showing potential CDL sorghum sites that can be added to ground truth. 

 

15.1.97. Toggle different layer combinations for the RGB values for the NDVI stack 

in the image for a combination that makes the crops stand out. Since every layer 

is a different NDVI date, certain combinations work better for different crops. In 

this example, additional sorghum is being added to frame 31032 thus I would 

use the NDVI stack ‘31032_NDVI_Stack_ammjjJJJAASO’. I found that a good 

combination that works for sorghum is setting Red to layer 10, Green to layer 9 

and blue to Layer 6. This means that the image combination is August (layer 10) 

August (layer 9) and July (Layer 6). 

 

Figure 167.Showing band combination adjustment 

 

15.1.98. Turn off the CDL so that just the NDVI composite is visible, with the bands 

that you have selected. I should become apparent that certain alike crops stand 

out based on the composite dates that you have chosen. The CDL’s 

classification isn’t always right, so using NDVI verification for adding ground 

truth data is a good additional process to get accurate additional ground truth 

locations. The figure below shows the 10-9-6 NDVI combination that was used 

to help identify sorghum. Notice that the sorghum appears yellow, while all of 
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the other surrounding crops do not appear this color. This is a good indication 

that the crops are in fact sorghum and that the CDL is correct in calling these 

crops sorghum. 

 

Figure 168. Showing the same extent as the previous CDL graphic, only this is the NDVI composite. 

Notice that the sorghum stands out in yellow, while all of the other different crops appear dull. 

 

15.1.99. Since theses sorghum crops have been verified by the NDVI composite, it is 

now safe do digitize the crops and attribute them as sorghum. Refer to the 

previous section on instructions on adding additional ground truth locations. 
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Process Step.3 (Classification) 

15.1.100. The third part of the classification involves performing the MLC 

classification.  

15.1.101. Landsat composite and NDVI composite cloud filled images are then 

stacked on a seasonal interval for each frame. Based on cloud suitability and the 

number of image dates present for each frame.  Both composites contain input 

images where frames were processed clipped to a buffered study area boundary.  

15.1.102. The reserved training ground truth data sets are available for 

classification procedures input once they have been checked using the multi-

temporal NDVI evaluation. With any possible outliers removed, the shapefile 

can be negatively buffered by a distance of 30m for classification signature 

extraction.   

15.1.103. ERDAS requires the training dataset is converted to raster format. The 

process can be performed in ERDAS or ArcGIS using a vector to raster 

conversion tool. Cell size should match the image to be classified and pixel 

snapping implemented. This insures signatures are extracted from the correct 

corresponding multi-band pixel values. 

15.1.104. The classification procedure is performed in ERDAS and is first started 

with the import and formatting of the training data. To start, the training data 

must be changed from continuous to thematic data type. Open a viewer in 

ERDAS  

15.1.105. Right click on the image in the contents panel and scroll to the metadata 

option. 

 

Figure 169. Showing the ERDAS metadata interface prompt 

15.1.106. On the Image Info window click Edit>Compute Statistics. 
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Figure 170. Showing Computing statistics for a continuous image in the metadata interface 

15.1.107. On the statistics Generation Options window that comes up, change the 

Skip Factor for x and y to equal 1, and change the Bin Type to be “Direct”.  

Click OK. 

15.1.108. On the Image Info window, click Edit>Change Layer Type. 
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Figure 171..  Image Info Window for thematic layer 

15.1.109. The displayed type of image will then change from Continuous to 

Thematic. 

15.1.110. Close the Image Info window.  On the Viewer window, click 

Raster>Attributes. 

15.1.111. On the raster attribute editor, click Edit>Add Class Names. 

15.1.112. Now go through each record in the raster attribute editor and label each 

class name and allocate a unique color to each crop type and click save. 

15.1.113. Signature Extraction and Classification 

15.1.114. Now extract the spectral signatures from the input Landsat composite 

masked imagery within the training parcels using the signature editor.  In 

ERDAS Imagine click the Raster>Supervised>Signature Editor. 
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Figure 172.Showing the ERDAS signature editor dialog 

15.1.115. Select Edit>Image Association. 

15.1.116. Select Landsat_composite_mask.img. 

15.1.117. Select Edit>Extract from Thematic Layer on the signature editor. 

15.1.118. Choose the Training Data for the Input Thematic File, and call the 

Output Signature File Landsat_composite_mask.sig, click OK. 

15.1.119. Once completed, load the Landsat_composite_mask.sig file into the 

signature editor. 

15.1.120. Name the class names and give them unique colors.  Save the 

Landsat_composite_mask.sig.  Evaluate each signature by band.# for histogram 

display and pixel count.  

 

Figure 173. Showing the ERDAS signature review interface 

15.1.121. Next, you will create a supervised classification of the 

Landsat_composit.img based upon the newly created 

Landsat_composite_mask.sig signatures.  On the signature editor, click Classify 

> Supervised. Populate the dialog with the following inputs: 

Input Raster – Multi-temporal Landsat stack 

Input Signature File – Signature file corresponding to the input raster 

Classification File – Output classified raster 

Distance File – Output QC review file 
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Figure 174. Showing the supervised classification interface 

15.1.122. Open the classified image in ArcMap and inspect the results. Review the 

distance file for any locations with higher values. As described in the ERDAS 

2013 help documentation: 

15.1.123. The brighter pixels (with the higher distance file values) are spectrally 

farther from the signature means for the classes to which they are assigned. 

15.1.124. These locations are more likely to be misclassified. If during the review 

the classification seems incorrect for a given reason, the following solutions 

should be reviewed: 
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 Removal of neighboring ground truth locations by re-evaluating NDVI based training 

signatures. 

 Additional of training data for classes with minimal location input. Will require NDVI 

validation. 

 Thresholding distance results for further analysis.   

o Process requires evaluating pixel results that are most likely incorrect. Results can 

be re-classed into a binary grid and used in masking composite img file. 

Additional training data can be used to re-classify the masked portion. Re-classify 

and re-evaluate the distance file until the classification appears correct. 

 

Process Step.4 (Accuracy Assessment) 

15.1.125. The forth part involves performing and evaluating accuracy assessment.  

15.1.126. Accuracy assessment is performed on the results of the parcel-level 

classification.  The accuracy assessment is the final review step to insure the 

classification procedure was performed correctly. Using ArcGIS Zonal 

Statistics, the majority classified crop type will be extracted for each reserved 

accuracy assessment parcel.  The results table indicates the majority crop type 

value for each accuracy-assessed parcel. A third column can be calculated to 

indicate the match and finally summary statistics can be ran to tabulate the 

counts.  

 

 

Figure 175. Showing the ArcGIS zonal statistics tool interface for extracting accuracy values 

15.1.127. Populate the zonal statistics tool to create and output summary of the 

classification results. 
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15.1.128.  

15.1.129. Using the table output from the summary statistics, populate an excel 

based template Error Matrix with the classification results. 

15.1.130.  

Figure 176. Showing the excel accuracy assessment matrix 

15.1.131. If accuracy percentages at the crop level are below anticipated 

standards, further analysis and refinement will be required.
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Process Step.5 (Parcel Crop Assignment) 

15.1.132. The final component of the procedure involves crop type assignments to 

individual parcel layers. 

15.1.133. With a Landsat frame classified, reviewed and corresponding accuracy 

assessment indicating suitable percentages, parcel crop types can be assigned to 

the parcel layer. The process is performed in ArcGIS using the zonal statistic 

majority function. The tool will extract the corresponding crop type for each 

parcel. Due to noise occurrences on parcel boundaries, it is suggested to 

negative buffer parcels by 30m in extraction crop types.  For parcels smaller 

than 30m that result in a geometry loss result back to the default parcel size and 

review results. Insure the extracted table is joined to the full parcel feature class. 

 

 

Figure 177. Shows the ArcGIS zonal statistics tool for extracting crop types 

 

15.1.134. The resulting zonal table can then be joined back to the parcel feature 

class on PARCEL_ID. As a QC measure, it is recommended to append the crop 

type from each classified frame as the overlap portion from adjacent frames 

provides cross-scene validation.  If differences are seen, further review will be 

required.  
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Trees, Riparian, Water, and Bare Ground Classification 

15.1.135. Extract an aerial image from the 2010 NAIP file geodatabase using the 

Copy Raster tool in Arc Toolbox. The tool is located at: Data Management 

Tools -> Raster -> Raster Dataset. 

 

Figure 178. Copy raster tool in Arc Toolbox 

15.1.136. Choose the appropriate output location for the copied raster file, ensure 

the No Data Value is 256, and choose the Pixel Type 8_BIT_UNSIGNED. 

 

Figure 179. Copy Raster tool input values 

Note: The extension .img creates an ERDAS IMAGINE file which reduces 

the file size and more characters can be used in the name of the output file. 

The Pixel Type, 8 Bit Unsigned integer, also reduces the file size of the 
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copied raster file and the value 256 ensures there is a numerical No Data 

Value assigned to the image that does not fall between 0 to 255. 

15.1.137. Clip the copied aerial image to the COHYST boundary using the Raster 

Clip tool in Arc Toolbox and a shapefile or feature class of the COHYST 

boundary. The tool is located at: Data Management Tools -> Raster -> Raster 

Processing. 

 

Figure 180. Raster Clip tool in Arc Toolbox 

15.1.138. Choose the appropriate output location for the clipped raster file, select 

the Output Extent which is the COHYST boundary,  check the box for Use Input 

Features for Clipping Geometry, and enter 256 for the No Data Value. 

 

Figure 181. Raster Clip tool input values 

15.1.139. Change the grid cell size of the aerial image from 3.32 ft (1 meter) to 

10ft (3 meters) using the Resample tool in Arc Toolbox. The tool is located at: 

Data Management Tools -> Raster -> Raster Processing. 
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Figure 182. Resample tool in Arc Toolbox 

15.1.140. Choose the appropriate output location for the resampled raster file, 

enter the value 10 for the new X and Y cell size for, and select NEAREST for 

the Resampling Technique. 

 

Figure 183. Resample tool input values 

15.1.141. Create a NDVI file of the resampled raster file using the Image Analysis 

window in ArcMap which is located on the Menu toolbar under the Windows 

tab at the top of ArcMap. 

 

Figure 184. Image Analysis window in ArcMap 
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15.1.142. Within the Image Analysis window click on the raster file that the 

NDVI file will be created for and then click on the NDVI processing button to 

create a temporary NDVI layer in ArcMap. 

 

Figure 185. Selected raster file in the Image Analysis window 

 

Figure 186. NDVI function in the Image Analysis window 

15.1.143. Create a raster file from the temporary NDVI layer using the Copy 

Raster tool in ArcToolbox using the appropriate input values. 
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Figure 187. Copy Raster tool input values 

15.1.144. Create a composite raster file of the NDVI raster file and Bands 1 and 2 

from the resampled raster image using the Composite Bands tool in ArcToolbox. 

The tool is located at: Data Management Tools -> Raster -> Raster Processing. 

 

 

Figure 188.  Composite Bands tool in ArcToolbox 

 

Figure 189.  Composite Bands tool input values 

15.1.145. Use the extent shapefile of the aerial image to clip the shapefile or 

feature class of the 2010 crop parcels within COHYST using the Vector Clip 

tool within ArcToolbox to create a new parcels shapefile. The tool is located at: 

Analysis Tools -> Extract. 
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Figure 190.  Vector Clip tool in ArcToolbox 

 

 

Figure 191.  Vector Clip tool input values 

15.1.146. Populate the PARCEL_ID or any other designated field in the clipped 

parcels shapefile with the value 1 using the Field Calculator within the attribute 

table in an edit session. 

15.1.147. Dissolve the clipped parcels shapefile based on the field calculated with 

the value 1 using the Dissolve tool in ArcToolbox. The tool is located at: Data 

Management Tools -> Generalization. 

 

Figure 192.  Dissolve tool in ArcToolbox 
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Figure 193.  Dissolve tool input values 

15.1.148. Create a raster file from the dissolved parcels shapefile using the 

Feature to Raster tool in ArcToolbox. The tool is located at: Conversion Tools -

> To Raster. 

 

Figure 194.  Feature to Raster tool in ArcToolbox 

15.1.149. Choose the field that the shapefile dissolve was based on, the 

appropriate output location for the raster file, and select the resampled raster file 

to ensure the output cell size is 10ft. 
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Figure 195. Feature to Raster tool input values 

Note: The output raster will contain two values, the value 1 for all of the 

parcels and the value No Data for everything else. That is why the original 

shapefile was dissolved on a field with the value 1 which is used as an input. 

Additionally, the output cell size of the parcel raster file needs to be the same 

as the resampled aerial image. 

15.1.150. Reclassify the values in the parcel raster file using the Reclassify tool in 

ArcToolbox. The tool is located at: Spatial Analyst Tools -> Reclass. 

 

Figure 196.  Reclassify tool in ArcToolbox 

15.1.151. Choose the Value field for the Reclass field and change the value 1 to 

No Data and the value No Data to 1. 
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Figure 197.  Reclassify tool input values 

15.1.152. Clip the reclassified raster file to the COHYST boundary using the 

Raster Clip tool in ArcToolbox. This creates a raster mask of the crop parcels 

within the extent of the composite aerial raster file. 

15.1.153. Create a mask raster file for the roads within the extent of the composite 

aerial raster file using the same steps that were used for the crop parcels. 

15.1.154. Mask the composite raster file with the parcel raster mask using the 

Extract by Mask tool in ArcToolbox. 
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Figure 198.  Extract by Mask tool in ArcToolbox 

15.1.155. Mask the new raster file with the road raster mask using the Extract by 

Mask tool in ArcToolbox. 

Note: At this point the composite raster file should have had the masking 

function performed on it twice for the parcels and roads. This removes the 

parcels and roads from the original composite raster file which will increase 

the accuracy of the classification. 

15.1.156. Copy the final masked raster file using the Copy Raster tool in order to 

set the final parameters of the raster file for classification. Set the NoData Value 

to 65536 and the Pixel Type to 16_BIT_UNSIGNED. 

 

Figure 199.  Copy Raster input values 
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15.1.157. Open ERDAS IMAGINE and click the Raster tab on the Menu Bar. 

 

Figure 200.  ERDAS IMAGINE Menu Bar 

15.1.158. Click on the Unsupervised tab and select Unsupervised Classification. 

 

Figure 201.  Unsupervised drop down menu 

15.1.159. Select the final raster mask file for the input raster file, choose the 

appropriate output locations for the output classification layer and signature file, 

set the number of classes to 50, and set the maximum iteration number to 10. 

Click OK. 



 

COHYST  

 2010 Land Use  

Classification Manual 

 

    Created Monday April 21
th
, 2014                                                       Page 110   

 

 

Figure 202.  Unsupervised Classification dialog box 

Note: The number of classes and maximum iterations shown above is just a 

recommendation and depends on user preference such as allowable 

processing time and accuracy of the classification. 

15.1.160. Once the classified raster file is created, add it to ArcMap along with the 

2010 clipped, resampled aerial image. The 2010 aerial image will be used to 

assign values to the 50 classes that were created in the classification such as 

trees, water, bare earth, and non agricultural areas. 

15.1.161. Right click on the classified raster layer in ArcMap, select Properties, 

and then click on the Symbology tab. 
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Figure 203.  Properties menu for the classified layer 

 

Properties tabs for the classified layer 

15.1.162. Click on Unique Values in the Show window. 

 

Figure 204.  Symbology tab property options 

Note: From here the symbol for each class can be changed to a preferred 

color or made hollow so it will not show depending on user preference. 

Using the aerial imagery, values (color) can be designated for each class that 

designates the land type. Colors can be changed by left clicking on the 

symbol to left of each class. 
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15.1.163. The classification results from each NAIP tile can then be reclassed into 

the corresponding classes and mosaiced into a seamless supplemental 

classification for static land cover classes. The 2010 supplemental classification 

is seen below and compared with the 2005 Landsat based classification method 

to the right and the 2010 NAIP input to the left.  

15.1.164. Classes include: Water, Riparian/Forest/Woodland and Barren areas. 

 

Figure 205.  NAIP classification results  

 

TASK IV.  IRRIGATED AND NON-IRRIGATED IRRIGATION SEPARATION 

16. Instructions to Classify Irrigated and Non-Irrigated Parcels 

The irrigation assignment procedure is performed using the crop classification and NDVI 

thresholding procedures to determine potential irrigation status. The results are then verified 

using ancelary GIS datasets including: pivots, wells and certified acres. The method is outlined 

in the following graphic. 
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Figure 206. Showing the irrigation assignment procedure as performed 

 

16.1.1. Find NDVI Landsat scenes that are minimally filled with clouds. Dates 

between July and August are typically best for crops such as corn and soybeans, 

as many crops typically show full cover between these dates.  

16.1.2. Once individual scenes have been selected, open up ArcMap.  

16.1.3. Load selected NDVI scene into ArcMap using the “Add Data” icon and 

navigate to the workspace of the selected scenes. 

 

Figure 207.  Add Data Icon 

16.1.4. Along with adding the selected NDVI scene(s) into ArcMap, also add known 

irrigation, ground truth, certified acres, center pivots, etc. shapefiles into 

ArcMap using the “Add Data” icon. 

16.1.5. In ArcMap, click on the “Search” icon located near the top of the screen.  
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Figure 208.  Search Icon 

16.1.6. Search for and click on “Zonal Statistics”. 

16.1.7. Use the crop type shapefile for the frame (e.g., corn, soybeans, alfalfa, etc.) 

as the “Input”, the crop type parcel feature ID (FID) as the “Zone Field”, the 

selected Landsat NDVI scene as the “Input value raster”. Specify the “Output 

raster” to save to your local workspace, and make sure to add the date of the 

scene and crop type of the zonal statistics in the output name. Specify the 

“Statistics Type (optional)” as “Mean” from the dropdown menu.  

 

Figure 209.  Zonal Statistics Icon 

16.1.8. The Zonal Statistics raster that is created shows the average NDVI value for 

each crop parcel within the selected frame. Based on this mean NDVI value for 

each parcel, irrigated and non-irrigated crops become apparent. 

16.1.9. Add the Zonal Statistics raster into the ArcMap document using the “Add 

Data” icon and make sure the Zonal Statistics raster is checked on. 

16.1.10. Compare the mean NDVI values from the zonal statistics to the shapefiles of 

known/potential irrigation shapefiles (certified acres, center pivots, etc.). The 

irrigated crops will have higher NDVI values than the non-irrigated crops. The 

mean NDVI value of the parcel can be determined using the “Identify” tool in 

ArcMap and clicking on the parcel. 

 

Figure 210.  Identify Icon 
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Figure 211. Example of zonal statistics of corn parcels for an NDVI scene.  

16.1.11. In Figure 174, orange represents higher mean NDVI values, while green and 

yellows represent lower mean NDVI values. Notice the ‘orange’ corn parcels 

exhibit higher NDVI values than the surrounding ‘green’ corn crops. The black 

circles represent known center pivots (irrigation). 

16.1.12. Based on the difference of the NDVI values, a threshold value can be 

determined in order to separate the irrigated crops from the non-irrigated crops. 

Record the determined threshold value in a tracking spreadsheet in order to keep 

track of thresholds for each selected Landsat scene and crop type. For example, 

it may be determined that all apparent irrigated corn crops of the scene show a 

mean NDVI value of greater than .75, while apparent non-irrigated corn crops 

show NDVI values below .75. Based on this example, a good threshold for 

irrigated corn for the scene may be .75.  

 While using the Identify tool to compare different NDVI values of the 

scene, certain trends will become apparent. For example, you may 

notice that most crops that have center pivots have NDVI values above 

certain values, and that crops that do not have center pivots have 

values below certain values.  

 Within ArcMap, you can right-click the scene and click on 

“Properties” → “Symbology”. From here you can classify the raster to 

reflect different colors for different values that you notice. Refer to the 

figure below for an example.  
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Figure 212.  Example of a zonal statistics raster of corn parcels, with center pivots repressing the blue circles.  

16.1.13. In Figure 175, the symbology has been changed to show parcels that have 

mean NDVI values greater than .7 to be red, parcels that have mean NDVI 

values between .6 and .7 to be orange, and parcels that have mean NDVI values 

less than .6 to be black. Since center pivots are a good indicator of irrigation, the 

corn parcels that are not associated with the center pivots are likely non-

irrigated. This particular symbology was chosen since it became apparent that 

the majority of corn parcels that had center pivots had NDVI values greater than 

.7 and that corn parcels that are not associated with center pivots had NDVI 

values less than .7 and thus a threshold value of .7 was determined for this 

example.  

 Notice that this method is not perfect. For example, if you 

look at the parcel that the black arrow in the bottom left of 

the figure is pointing to, this parcel has a value less than .7 

and is thus orange. Although this parcel is likely irrigated 

since it has a center pivot, the parcel’s NDVI is less than the 

threshold and will be classified as non-irrigated. Conversely, 

if you notice the parcel that the arrow on the right hand of 

the figure is pointing to, this parcel has a value of higher 

than .7 and thus is red in color. Although this parcel is not 

associated with a center pivot, and is likely not irrigated, the 

NDVI value of the parcel is above the threshold, and will be 

classified as irrigated. Like mentioned previously, this 

method is not perfect, but overall, the threshold of .7 

correctly identified the likely irrigated and non-irrigated 

corn parcels.  

Note: Even the slightest adjustment in the threshold value can start to 

under/over-estimate the irrigated and non-irrigated crops. Refer to the figures 

below for examples. 
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Figure 213.  Example showing corn parcels with the best determined threshold of .7.  

16.1.14. In Figure 176, notice this threshold correctly identifies corn parcels with 

center pivots as irrigated (red) while identifying corn parcels that do not have 

center pivots as non-irrigated (orange and black). 

 

 

Figure 214.  Example where the threshold was raised from .7 to .72.  

16.1.15. In Figure 177, notice the arrows pointing out parcels that would now be 

classified as non-irrigated since they are below the new threshold, even though 

the parcels are likely irrigated and appear irrigated with the .7 threshold. This 

example shows how by just raising the threshold slightly, UNDER-

ESTIMATION of crops occurs. 

 

 

Figure 215.  Example showing what would happen if the threshold was lowered from .7 to .68.  

16.1.16. In Figure 178, notice the black arrow pointing out a corn parcel that would 

now be classified as irrigated with the lowered threshold even though the parcel 

is not associated with a center pivot and likely not irrigated. This example shows 

how by just lowering the threshold slightly, OVER-ESTIMATION of irrigation 

crops occurs. 

2 

1 

3 
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16.1.17. Evaluate and record thresholds for each individual crop type and every 

selected NDVI scene. 

Note: The example in the previous step used a center pivots shapefile to 

evaluate thresholds, but other shapefiles should also be used such as certified 

irrigation acres, flood irrigation, etc. to evaluate threshold values. 

 

Figure 216.  Graph showing NDVI thresholds vs. date for each crop type.  

16.1.18. In Figure 179, notice the corn thresholds are highest around late July and 

soybean thresholds are highest between July and August. Alfalfa is harvested 

multiple times throughout the summer, so NDVI thresholds vary greatly. 

16.1.19. After all thresholds are evaluated, the next step is to “Reclassify” each Zonal 

Statistics raster so that all pixel values beneath the threshold can be classified as 

0 (non-irrigated), and that all pixel values above the threshold are classified as 1 

(irrigated).  

16.1.20. In the ArcMap document, click on the “Search” icon. 

 

Figure 217.  Search Icon 

16.1.21. Search for and click on “Reclassify”. 

16.1.22. Use the Zonal Statistics raster as the “Input Raster”, use “Value” as the 

“Reclass Field”, set all “Old values” that are lower than the recorded threshold 

to a “New value” of 0, and all “Old values” that are higher than the threshold to 
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a “New value” of 1. Make sure to also set ‘NoData’ values to 0 as well. Set the 

“Output raster” to the local workspace with a naming convention such as 

‘97_soy_reclass’ showing that 97 is the Julian day of the year, that the crop is 

soy, and that the scene has been reclassified. 

 

Figure 218.  Reclassify tool. (Note that the example threshold is .75) 

16.1.23. Reclassify all of the scenes that have had zonal statistics ran on them and 

thresholds determined. By reclassifying all of the rasters, there will now be 

individual rasters that are binary with non-irrigated pixels having values of 1 and 

non-irrigated pixels having values of 0.  
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Figure 219.  An example reclassified corn scene.  

16.1.24. The ‘green’ represents corn pixels that have values above the threshold and 

have been reclassified to a value  of 1 (irrigated) and the ‘black’ represents corn 

pixels that have values  below the threshold and have been reclassified to a value 

of 0 (non-irrigated). 

16.1.25. The next step is to add all of the reclassified scenes of each individual crop 

type together by means of the “Plus” tool. In the ArcMap document, click on the 

“Search” icon. 

 

Figure 220.  Search Icon 

16.1.26. Search for and click on “Plus”. 

Note: The “Plus” tool only allows for the addition of two rasters at a time, so 

this process may have to be repeated, depending on how many reclassified 

rasters of each crop type there are. Refer to section 2.0 for instructions on 

how to use ArcGIS Model Builder to more easily add multiple rasters.   

16.1.27. For the “Input raster or constant value 1” use one of the reclassified rasters 

(e.g., ‘29031_195_soy_reclass.img), and for the “Input raster or constant value 

2” use a different reclassified raster (e.g., ‘29031_212_soy_reclass.img’). Set the 

output raster to your local workspace with a naming convention such as 

‘29031_195_plus_212_soy.img’. 
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Figure 221.  Plus Icon 

16.1.28. Repeat the previous step (1.19) until all of the reclassified rasters of each 

crop type have been added together for the frame. Once all of the reclassified 

rasters have been added together, there will be a raster of all of the corn, a 

separate raster for all of the soybeans, etc. for all of the crop types within the 

frame. 

Note: If there are many scenes that need to be added together, ArcGIS Model 

Builder can be used to make the process more efficient. An example of a sample 

model for adding reclassified rasters can be found in section 2. 

 

Figure 222.  Example of a portion the result raster of the Plus operation on 4 reclassified corn rasters.  

16.1.29. The ‘green’ represents corn pixels that have been classified as irrigated in 3 

of the 4 reclassified rasters and the ‘blue’ represents  corn pixels that have been 

classified as irrigated in all 4 reclassified rasters. 

16.1.30. After all of the rasters for the frame have been added together using the plus 

tool, the next step is to reclassify the final added raster for the specific crop type 

(e.g., soybeans). This reclassification is needed since the final plus raster will 

have values of 0,1,2,3,4,5…. depending on how many rasters were added. In the 

ArcMap document, click on the “Search” icon. 

Search for and click on “Reclassify”. 

16.1.31. Use the final Plus raster as the “Input Raster”, use “Value” as the “Reclass 

Field”, leave the “Old values” just as they are, and set the “New values” that are 

greater than ‘0’ to a value of ‘1’. Set the “Output raster” to your local workspace 

with a naming convention such as ‘29031_soybeans_reclass.img’. Old values of 

‘1’ mean that the crop was classified as irrigated in 1 scene, old values of 2 
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mean that the crop was classified as irrigated in 2 scenes, and so on. Doing this 

reclassification will create a binary raster of all irrigated crop types having 

values of 1 and all non-irrigated crops having a value of 0. 

 

Figure 223.   Reclassify Icon. Note that all “New Values” greater than 0 are given a value of 1. 

16.1.32. Repeat the previous step (14.1.31) for all crops that need irrigation 

classification (corn, alfalfa, soybeans, etc.) for the frame. 

16.1.33. There will now be rasters for each crop type with each raster showing 

irrigated crops as a value of 1 and non-irrigated crops as a value of 0 for each 

frame. 

 

Figure 224.  An example of a section of a final reclassified raster of all of the added corn rasters.  

16.1.34. The ‘green’ represents corn pixels that have been reclassified to a value of 1 

(irrigated) and the ‘black’ represents corn pixels that have been reclassified to a 

value of 0 (non-irrigated).  
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16.1.35. The next step will be to add all of the reclassified crop rasters of the frame 

together to get a raster for each scene that has all of the corn, soybeans, alfalfa, 

etc. added together into one composite raster. Use the ‘Plus’ tool to add the crop 

types of the frame together. For example, use the final 29031 corn raster as the 

input raster 1 and final 29031 soybeans raster as the input value 2. Do this for all 

crops of 29031 until all of the crops have been added together for the frame. 

You should now have a final irrigation raster for all of the irrigated crops for the 

frame. Do this for all of the frames in the study area. 

16.1.36. The next step is to add all of the irrigated rasters from each frame together to 

get one main irrigation raster for the entire study area. Using the ‘Plus’ tool, add 

two of the frames together. This is necessary since only two rasters can be added 

at once. Keep adding frame rasters two at a time until all of the frame rasters 

have been added together.  

16.1.37. There should now be a raster that is the irrigated raster for all of the scenes. 

This needs to be reclassified since there is overlap between scenes that have 

been added together. All of the values greater than ‘0’ can all be reclassified 

back to ‘1’ to get a final reclassified raster of all irrigated crops having values of 

‘1’ and all non-irrigated crops having a value of ‘ 0’. Use the ‘Reclassify’ tool 

and use the irrigated raster created in the previous step as the ‘Input raster’ and 

use the ‘Value’ field as the ‘Reclass field. Set all of the ‘Old values’ that are 

greater than 0 to have ‘New values’ of 1. Set the output raster to your 

workspace, with a naming convention such as ‘2010_irrigation.img’. 

 

Figure 225.  Reclassify Icon. Note that all “New Values” greater than 0 are given a value of 1. 
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16.1.38. The next step will be to Join the values of the reclassified raster back to the 

ag-parcel shapefile. In ArcMap, click on the “Search” icon located near the top of 

the screen. 

 

Figure 226.  Search Icon 

16.1.39. Search for and click on “Zonal Statistics as Table”. 

16.1.40. Use the ag-parcel shapefile as the “Input raster or feature zone data”, the 

parcel ID as the “Zone Field”, the final irrigated crop raster as the “Input value 

raster”. Specify the “Output table” to your local workspace.. 

 

Figure 227.  Zonal Statistics as Table Icon 

16.1.41. Add the newly created zonal statistics table and the ag-parcel shapefile to the 

ArcMap document using the “Add data” icon to navigate to the location of the 

table and the crop type shapefile. 

 

Figure 228.  Add Data Icon 

16.1.42. Under the Table of Contents in the ArcMap document. Right-click on the ag-

parcel shapefile, select “Joins and Relates” → “Join”. 

16.1.43. Under “1.” select the parcel ID (e.g., FID) as the field that the join will be 

based on. 
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16.1.44. Under “2.” select the newly created zonal statistics table from the drop down 

menu. 

16.1.45. Under “3.” Select the feature ID (FID) as the field in the table to base the join 

on. 

16.1.46. Select “Keep only matching records” and select “OK”. 

 

Figure 229.  Join data dialog 

16.1.47. There will now be an attribute within the ag-parcel shapefile with a field 

named ‘Majority’ that has values of ‘1’ for irrigated crops and ‘0’ for non-

irrigated crops. 

Note: This Join does not make the new Majority field permanent. To 

permanently keep the Majority field within the crop type shapefile: 

 Right click the crop type shapefile that has the Join. 

 Select “Data”→ “Export Data” 

 Under “Export:” select “All features” from the drop down menu. 

 Under “Use the same coordinate system as:” select the radio button 

“this layer’s source data”. 

 Set the “Output feature class” to your local workspace with a name 

showing that the irrigation Majority attribute has been added. An 
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example of a name of the output feature class would be 

‘2010_irrigation_majoirty’. Repeat these steps for all other crop types 

that need irrigation status determined. 

16.1.48. The ag-parcel shapefile now has a field showing whether or not that certain 

crop parcel is irrigated or not. If the parcel is irrigated, there will be a value of 1 

under the Majority field. Alternatively, if the parcel is non-irrigated, there will 

be a value of 0 under the Majority field. 

 

Figure 230.  Example attribute table of irrigated and non-irrigated parcels. 

16.1.49. Notice the ‘FID’ is the individual parcel, and the field ‘MAJORITY’ is the 

irrigation status with the number ‘1’ representing irrigated parcels and the 

number ‘0’ representing non-irrigated parcels.  

15. Verifying irrigation status using certified acres, wells, and center pivots. 

Using just the NDVI method to evaluate thresholds tends to both over-

estimate and under-estimate actual irrigation status. After the original 

irrigation status has been evaluated, verification steps are needed to help 

eliminate some of the over and under-estimation. This can be done by using 

known certified acres, well data, and center pivot data.  

15.1 Within ArcMap, bring in the yearly parcel layer that has the irrigation status 

assigned. Also bring the shapefiles for certified acres, wells and yearly pivots. 

15.2 Open the attribute table of the original parcel layer. Add a new field to the 

shapefile and name the new field ‘Irrig_Ver’. Right click on this new field and 

select ‘Field Calculator…’ Calculate the field to be whatever the original 

irrigation field is that has the values of the original irrigation status (this field 

should have 1’s and 0’s to represent irrigated and non-irrigated parcels based on 

NDVI thresholds). The new ‘Irrig_Ver’ field will be where the editing will be 

done to verify/change irrigation status. 

15.3 Use the selection tool on the top of the screen and click on ‘Select By Location’. 

Use the parcel layer as the ‘Target layer’ and the Certified Acres shapefile as the 

‘Source layer’. For the ‘Spatial selection method’ click on ‘have their centroid in 

the source layer feature’. Click on OK. This will select all of the parcels that 

have their center within the certified acres.  
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Figure 231. Showing how to select parcels that intersect certified acres. 

15.4 In ArcMap, right click on the parcel layer, click on ‘Selection’ and then click on 

‘Create Layer From Selected Features’. This will create a new layer within 

ArcMap that is all of the parcels that intersect certified acres. Rename this layer 

to have a naming convention that shows that the layer is certified parcels. An 

example name would be ‘COHYST_Landuse_2006_Certified’.  

15.5 Now that there is a layer of all of the parcels that are certified for irrigation, you 

need to create a layer of the parcels that are not certified for irrigation (do not 

intersect center pivots). To do this, right click on the original parcel layer, and 

select ‘Open attribute Table’. Within the attribute table, select the ‘Switch 

Selection’ icon from the toolbar at the top of the attribute table. This will now 

switch the selection from parcels that intersect certified acres to parcels that do 

not intersect certified acres.  

 

Figure 232. Switch Selection Icon 

15.6 In ArcMap, right click on the parcel layer, click on ‘Selection’ and then click on 

‘Create Layer From Selected Features’. This will create a new layer within 

ArcMap that is all of the parcels that do not intersect certified acres. Rename this 

layer to have a naming convention that shows that the layer is not certified 

parcels. An example name would be ‘COHYST_Landuse_2006_NonCertified’. 

15.7 Next, do a ‘Select By Location’ between the CERTIFIED parcel layer, and the 

well layer for the year. Use ‘intersect’ as the spatial selection method. This will 

select all of the certified parcels that intersect wells.  
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15.8 Start an edit session and chose this certified parcel layer to be the shapefile to be 

edited.  

15.9 Select all of the parcels that intersect wells and have been classified as non-

irrigated (0) based on NDVI thresholds. Since these parcels were originally 

classified as non-irrigated, have a well on them, and are certified, the irrigation 

status needs to be changed from non-irrigated (0) to irrigated (1). Use the 

‘Irrig_Ver’ field to make these changes.   

15.10 Next, do a ‘Select By Location’ between the NON-CERTIFIED parcel layer, and 

the well layer for the year. Use ‘intersect’ as the spatial selection method. This 

will select all of the certified parcels that DO intersect wells. Create a new layer 

from the selected features. This will create a new layer within ArcMap that is all 

of the non-certified parcels that intersect wells.  

15.11 Within the NON-CERTIFIED parcel layer attribute table, switch the selection. 

This selection will now be all of the non-certified parcels that DO NOT intersect 

wells.  

15.12 Open the attribute table of the non-certified parcels that intersect wells. Click on 

‘Select By Attributes’ and select all of the parcels that have center pivots. With 

this selection, if the original irrigation status was classified as non-irrigated (0), 

change these parcels to irrigated (1) within the ‘Irrig_Verif’ field. Even though 

these parcels aren’t certified, they do have center pivots and to intersect wells, 

and are therefore likely irrigated.  

15.13 Open the attribute table of the non-certified parcels that DO NOT intersect wells. 

Click on ‘Select By Attributes’ and select all of the parcels that DO NOT have 

center pivots. With this selection, if the original irrigation status was classified as 

irrigated (1), change these parcels to non-irrigated (0) within the ‘Irrig_Verif’ 

field. These parcels are not certified, do not have center pivots, and do not have a 

well on them. Because of this, these parcels are likely not irrigated. 

15.14 Create a selction on parcels that do not interest wells. Create a new layer from 

the selected features. Select parcels from this layer that interstect the pivots layer. 

Change the irrigation status from non-irirgated (0) to irrigated (1). 

15.15 If the parcel is classified as fallow, change the irrigation status to non-irrigated. 

15.16 The ‘Irrig_Verif’ field will now have the verified irrigation status of the parcels 

based on verifying the parcels with certified acres, wells, and center pivots.  
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Instructions to use ArcGIS Model Builder to process multiple rasters 

16.1.50. ArcGIS Model builder can be used to process multiple rasters in one ‘area’. 

Model Builder can be used to perform zonal statistics on more than one raster, 

reclassify multiple rasters, and to add (Plus) multiple rasters. Below is an 

example of how to use Model Builder to add (Plus) 2 different reclassified corn 

rasters. 

 

ArcCatalog Model Builder 

16.1.51. Open ArcCatalog. Select the “Model Builder” icon from the top of the 

ArcCatalog toolbar. 

 

Figure 233.  Model Builder icon 

16.1.52. From the ‘Catalog Tree’ in ArcCatalog, drag all of the reclassified crop 

rasters from the ‘Catalog Tree’ into the model. Only bring in rasters from crop 

types of a single frame at a time. For example, use different models for each of 

the different frames.  

 

Figure 234.  2 reclassified corn rasters after being dragged into Model Builder 
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In ArcCatalog, click on the “Search” icon near the top of the screen. 

 

Figure 235.   Search Icon 

16.1.53. Search for “Plus”. Drag the “Plus” into the model. Since the Plus tool can 

only add two rasters at a time, you may need to drag in a Plus tool for every two 

rasters that are in the model if you are need to add more than two rasters. For 

this specific example, there are 2 reclassified corn rasters, thus only one Plus 

tool is required in order to add the two corn rasters. 

 

Figure 236. Model after dragging in the Plus tool. 

 

Click on the “Connect” icon within the model.  

 

Figure 237.  Connect icon 

16.1.54. After clicking on the “Connect” icon, a wand will appear that will allow you 

to connect the rasters to the Plus tool.  

16.1.55. Use the wand to connect the rasters to the Plus tool. Once you connect one of 

the rasters to the Plus tool, a prompt will come up asking whether you want the 

raster to be “input raster or constant value 1” or “input raster or constant value 

2”. It doesn’t matter which raster is input 1 or 2 just as one raster is input 1 and 

the other raster input 2.  
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16.1.56. Connect all of the input rasters into the Plus tools.  

16.1.57. Double-click on the “Plus” tool to set the “Output raster” to the local 

workspace with a naming convention such as ‘29031_corn’ showing that the 

tool is adding together the two corn rasters from frame 29031. 

 

Figure 238.  Example model after connecting the input rasters to the Plus tools. 

16.1.58. Repeat these steps for each crop type within the frame to get rasters of all 

added crop types within the frame.  

16.1.59. You will now have a raster for each crop type that shows irrigated crops for 

the scene. The raster will have values such as 0,1,2,3,… with 0 being non 

irrigated, 1 being irrigated in one scene, 2 being irrigated in two scenes, and so 

on. You now need to reclassify each crop type raster to set all values greater 

than 0 as irrigated (va1ues of 1). Drag in the ‘Reclassify’ tool into model builder 

and connect the added crop type raster into the tool (i.e. 32031_corn.img). 

16.1.60. Double click on the tool to bring up the ‘Reclassify’ dialogue. Set the 

‘Reclass field’ to be ‘value’ and make sure to change all of the old values that 

are greater than 0 to have new values of 1. Set the output to be your workspace 

and give the raster a name convention to show that the raster has been 

reclassified.  
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Figure 239.  showing reclassification of a corn raster  

16.1.61. Now, use the ‘Plus’  tool again to add all of the reclassified crop rasters 

together. For example, use the ‘Plus’ tool to add the reclassified corn, soybeans, 

Winter Wheat, alfalfa, etc. to get one main irrigation raster of all of the irrigated 

crops in the scene. Since you can only add two crops at a time, multiple ‘Plus’ 

tools may be needed depending on how many crops you are trying to add. The 

final output should be all of the reclassified crops added together for the scene. 

Give the final ‘Plus’ and output that shows that the output raster is all of the 

frame’s crops added together (i.e. 32031_ALL_CROPS.img) 

 

Figure 240.   showing the final ‘Plus’ raster for the frame 32031 

16.1.62. Repeat for all of the frames in the study area to get a final raster for EACH 

frame that has all of the irrigated crop types added together.  

16.1.63. The next step is to add all of the frame’s irrigated crops together. Drag into 

the model the final crop rasters that were created in step 14.6.8 for every frame 

(29031_ALL_CROPS.img, 29032_ALL_CROPS.img, etc.) 

16.1.64. Drag into the model the ‘Plus’ tool which will be needed to add together the 

individual frame rasters into one final master irrigation raster. Multiple ‘Plus’ 

tools will be needed depending on how many scenes you are adding together. 
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For example, you may need to add ‘29031+29032’ to ‘30031+30032’ to 

‘31031+31032’ to ‘32031’; In this case, six ‘Plus’ tools will be needed to add all 

of the frames together to get a master unclassified raster of all of the irrigation. 

Because of overlap between frames, this raster will need to be reclassified to 

show all values greater than 0 to be irrigated (values of 1). Give this output 

raster a naming convention that shows that the raster still needs to be 

reclassified. 

16.1.65.  

Figure 241.  showing a model that adds irrigation rasters from each frame (blue) to get a final, unclassified 

irrigation raster 

 

16.1.66. In ArcCatalog, click on the “Search” icon. 

 

Figure 242.  Search Icon 

16.1.67. Search for “Reclassify”.  
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16.1.68. Drag the “Reclassify” tool into the model.  

16.1.69. Connect the final added raster from the final Plus operation created in step 

14.6.11  into the “Reclassify” tool.  

 

Figure 243.  Example model showing the addition of the Reclassify tool 

16.1.70. Double-click on “Reclassify”. 

16.1.71. Use the final Plus raster as the “Input Raster”, use “Value” as the “Reclass 

Field”, leave the “Old values” just as they are, and set the “New values” that are 

greater than ‘0’ to a value of ‘1’. Set the “Output raster” to your local workspace 

with a naming convention such as ‘2010_ALL_IRRIGATED.img’. Old values 

of ‘1’ mean that the crop was classified as irrigated in 1 frame, old values of 2 

mean that the crop was classified as irrigated in 2 frames, and so on. Doing this 

reclassification will create a binary raster of all irrigated crop types having 

values of 1 and all non-irrigated crops having a value of 0. 

 

Figure 244.   Reclassify tool within model to get the final irrigated raster 
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16.1.72. Click on the “Validate Entire Model” icon located on the toolbar at the top of 

the model. 

 

Figure 245.  Validate Entire Model icon 

16.1.73. Click on “Model” → “Run Entire Model”. This will run all of the process 

within the model, including all of the Plus processes and the Reclassify process.  

16.1.74. The final raster created from the Reclassify process will be a binary raster 

containing irrigated crops with values of 1 and non-irrigated crops with values 

of 0 for the entire study area. 
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APPENDIX. A 

Tools and scripts described within the COHSYT 2010 Land Use Classification Manual are 

provided to project sponsors by special request.  Please send inquires to the following: 

 

 
2950 East Harmony Road 

Suite 390 

Fort Collins, CO 80528 

970-484-7573 
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